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Editorial
Welcome to issue 45, coming to you 
from a cooling U.K. (after a debatable 
summer), in which we aim to teach 
you the art of perspective, lighting and 
composition within our many great 
tutorial series’ this month!

Darren Yeow is back with us to take 
us through the painting of a beautiful 
oriental-style scene which starts from 
just a simple 3D base knocked up 

using the free and intuitive software, Google SketchUp (p.50). This is the 
third tutorial in this series and we’re really pleased with how our artists 
have been using Google SketchUp in different ways to achieve their 
own unique goals. We hope you’ve enjoyed what we’ve brought you 
so far and that you’ll learn many new techniques to help speed up your 
painting by integrating 3D into your workflow over this and our coming 
issues.

We welcome Björn Hurri to this issue to teach us a thing or two about 
creating character concept designs from an inside-industry point of view 
(p.72). Taking the theme of a warrior and a Photoshop paintbrush, he 
speedily paints for us a character in both an interesting front and back 
pose – showing us a neat trick of how to quickly get your back pose from 
the front without too much trouble along the way, too. The importance 
of Björn’s workshop is all about creating a character that a 3D modeler 
can easily work from, which is perfect for this series contributed to by 
professional artists working in the industry, including Darren Yeow and 
Bruno Werneck. We’ll be discussing dynamic and exaggerated poses 
next month when we introduce Mark McDonnell to 2DArtist, a designer 
working for the animation and entertainment industry, and author of the 
recent book on gesture drawing, The Art & Feel of Making it Real. In 
the final chapter of the series we’ll be inviting David Smit to share his 
lessons on camera placement, framing, fore-shortening, and distortion. 
So plenty to look forward to!

Fans of Nykolai Alexander’s work will be particularly thrilled to see 
her appear in three great articles this month. Not only is Nykolai 
taking us through the third chapter of our Beginner’s Guide to Digital 
Painting series (p.80), but she’s also here to teach and create for us 
the most stunning set of custom brushes for fabric and lace – shown 
in demonstration on this month’s cover image (p.62). But even that’s 
not all! On top of this we also have an exclusive for 2DArtist: an artist-
on-artist interview by Nykolai Aleksander who puts the one and only 
Justin Lassen under the spotlight to find out about his life and plans 
following his work on the Synaesthesia projects (p.26). This is a beautiful 
interview featuring work by greats such as Alex Ruiz and John Wallin 
Liberto, accompanying the soulful responses from CG community 
legend, Justin Lassen.

Our artist interview is with Guillaume Menuel whose work we have fallen 
so much in love with that we’ve had to get it printed for the office walls! 
Guillaume has the ability to turn just a few brushstrokes into a powerful 
masterpiece, and currently a concept artist for Ubisoft, Quebec City, 
he took some time  away from his digital canvas to satisfy our intrigue. 

001

006

018

026

038

050

062

072

080

092

098

102

Contents 
What’s in this month?

 Guillaume Menuel
Concept Artist at Ubisoft

 

Sketchbook 
The Sketchbook of Cliff Childs

Beyond Synaesthesia 
Interview with Justin Lassen

The Gallery 
10 of the Best 2D Artworks

Using 3D as a Base for 2D 
 3D Paint-Over by Darren Yeow

Custom Brushes 
Fabrics & Lace by Nykolai Aleksander  

 

Dynamic Characters 
Part 3 – Speed Painting & Concept Design

Digital Painting
Beginner’s Guide by Nykolai Aleksander

 

‘Hovercraft Parrot’
Project Overview by David Munoz Velazquez

‘‘‘Containment Breach Sub-Level 5’
Digital Art Masters: V4 Free Chapter

About us 
3DTotal.com Ltd Information & Contacts

Free Stuff!
Wherever you see this 

symbol, click it to download 
resources, extras!

Editor 
Lynette Clee

Lead Designer
Chris Perrins

Layout 
Layla Khani 
Matt Lewis

Marketing
Jo Hargreaves

Content 
Lynette Clee

Tom Greenway
Richard Tilbury
Chris Perrins

Jo Hargreaves

Proofing
Lynette Clee

Jo Hargreaves

Check out his playful portfolio on p.6 for a generous helping of inspiration!

We feature Cliff Childs in our Sketchbook article this month, who has 
currently just returned from an internship at Sony Santa Monica Studios. 
Delve into this up-and-coming artist’s sketchbook on p.18 for tips on how 
to keep your concepts original and exciting, and then be sure to hop on 
over to our “making of” featuring the uniquely titled image, Hovercraft 
Parrot, on p.92, by David Munoz Velazquez – a truly inspired image from 
a fantastic portfolio that we’re excited to learn a little more about!

I shall leave you to discover the Gallery and get cracking with your own 
masterpieces! See you next month for more where this came from. Ed.

http://www.2dartistmag.com


Contributors

Setting up your PDF reader 
For optimum viewing of the magazine it is recommended that you have 

the latest Acrobat Reader installed.  

You can download it for free here:  DOWNLOAD!   

To view the many double-page spreads featured in 2DArtist magazine, 

you can set the reader to display ‘two-up’, which will show double-

page spreads as one large landscape image: 

   

1. Open the magazine in Reader;   

2. Go to the View menu, then Page display;  

3. Select Two-up Continuous, making sure that Show Cover 
Page is also selected.

Get the most out of your 

Magazine!
If you’re having problems viewing the double-page spreads that we 

feature in this magazine, follow this handy little guide on how to set 

up your PDF reader!

http://www.adobe.com/products/acrobat/readstep2.html
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Contributing Artists
Every month many artists around the world contribute to 3DCreative and 

2DArtist magazines. Here you can find out more about them. If you would 

like to be a part of 3DCreative or 2DArtist magazine, please contact: 

lynette@3dtotal.com

Guillaume  
Menuel 
A 27-year old French artist 

currently living in Quebec, 

Canada. He’s now working 

as a concept artist at Ubisoft 

in Québec City after four years at Ubisoft in Paris, 

where he worked as a 3D artist and artistic director. 

He’s also currently thinking about a comic project 

based on his recent personal works.

  

http://gmgallery.blogspot.com/

guigui_oni@hotmail.com

Justin  
Lassen

A well respected multi-

instrumentalist, composer, 

remixer and producer with 

nearly 15 years of experience in 

the music, film, and video game industries. Lassen’s 

masterful compositions have been praised and 

quoted by leading CG artists, film, game and music 

professionals the world over. In 2006 he released his 

wildly successful “Synaesthesia” series, melding the 

worlds of music and CG artwork together. 

http://www.justinlassen.com/

jl@justinlassen.com

Nykolai 
Aleksander
Born in Germany in 1978, she 

moved to England in 1999, 

and currently lives in South 

Africa with her husband. She’s 

been painting digitally since 2002, and works as 

a freelance illustrator for both private clients and 

companies.

http://www.admemento.com 

x@admemento.com

http://www.2dartistmag.com
mailto:lynette@3dtotal.com
http://gmgallery.blogspot.com
mailto:guigui_oni@hotmail.com
http://www.justinlassen.com
mailto:jl@justinlassen.com
http://www.admemento.com
mailto:x@admemento.com
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Björn 
Hurri 
A concept artist and illustrator 

currently employed by multi 

award-winning, The Creative 

Assembly. He spends most 

of his days painting illustrations and concepts for 

all of their current and future titles, and in-between 

spending his time painting both day and night, he 

takes care of his wonderful wife and his now one-

year old son. 

 

http://www.bjornhurri.com/

bjornhurri@hotmail.com

Cliff 
Childs
Moved to the L.A. area from 

St. George, Utah to attend Otis 

College of Art and Design. His 

undying love for videogames 

led him to discover the world of digital painting and 

concept art. He has recently been part of the God of 

War 3 team as a junior concept intern at Sony Santa 

Monica Studios. He plans on one more year at Otis 

before pursuing a career as a concept/freelance 

artist and illustrator. 

http://cliffsconcepts.blogspot.com/

cliffchilds@gmail.com

David Munoz 
Velazquez 

A multi-disciplinary artist 

specializing in character design, 

lighting, and digital sculpting. 

He studied graphic design for 

five years, after which time he worked as a freelance 

graphic designer, also spending time painting. 

Before moving to the animation industry he worked 

in videogames for four years, and for another year 

freelance. He’s currently working in the animated film 

industry, at Kandor Moon. 

http://www.munozvelazquez.com/

munozvelazquez@gmail.com

Darren
Yeow

27-year old self-taught 

illustrator, originally hailing 

from Adelaide, has worked as 

a concept artist, user interface 

designer and art director in video game companies 

for the past four years, and currently lives in 

Melbourne. Outside his full-time role as an in-house 

concept artist working on next-gen games, he tutors 

hopeful young artists, works on commissioned 

freelance projects, and is writing a book for those 

wishing to pursue a career in concept art.

darren@stylus-monkey.com

http://www.2dartistmag.com
http://www.2dartistmag.com
http://www.bjornhurri.com
mailto:bjornhurri@hotmail.com
http://cliffsconcepts.blogspot.com/
mailto:cliffchilds@gmail.com
http://www.munozvelazquez.com
mailto:munozvelazquez@gmail.com
mailto:darren@stylus-monkey.com


We fire a few random questions at Guillaume Menuel and he shoots 

back some whacky answers ... well I guess that’s how an interview 

usually works, but anyway it’s a good 

read (mainly about bikini girls and 

robots) so get going!

“It’s a vision of an 
apocalyptic world at war 

where a stupid army 
full of mechs and big 

vehicles decides to invade 
beaches, because there’s 

sun at the beach you 
know...”
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Interview with Guillaume 
Menuel
Hi Guillaume, can you start by telling us a little 

about yourself and what you do for work and 

play?

Hi Tom, I’m a 27 year old French artist. After 

four years working for Ubisoft, Paris as a 

3D artist and artistic director, I left last year 

for Ubisoft, Quebec City where I’m currently 

working as artistic director.

As you can imagine, after work I need to paint 

and draw for myself; to escape from a very 

binding industry and have some fun. I like video 

games a lot and I like my work, but I can’t only 

devote myself to it. So that’s why personal 

painting, playing music, movies, beer and 

friends are so welcome!

Sounds like a nice lifestyle! Having moved 

from Paris to Quebec City, what would you say 

are the main differences between a French 

Canadian city and French city?

People’s mentality is so different! I have the 

feeling here that everything is much more 

simple. In Quebec I can really breathe! Paris 

and Quebec City are two different dimensions; 

I love both, but Quebec City is such a peaceful 

and sweet place to live. But I must say I do miss 

the energy of Paris. It is a very inspiring city ...

Red stars and red bikinis! I see them 

everywhere in your portfolio; there are lots of 

bikinis throughout and you seemed to grow fond 

of stars in 2008 and 2009, why is this?

Thanks for the question, it’s the first time I’ve 

had to wonder about the whys of all of this. Well, 

I have a simple answer for bikinis, just one word: 

sexy! There is no great philosophical answer, 

I’m afraid, just a primary feeling. But I don’t want 

to represent girls as stupid big-boobed babes; I 

draw them as strong characters. They’re sexy, 

but don’t try to fool them. 

For the stars, as you’ve seen it’s a military 

representation - I always been fascinated by 

military visuals. Also the star is a cool graphical 

pattern, I like it for its simplicity and strength 

and I’m fascinated with its use in political and 

military history. But I don’t want to use it just 

because it’s cool; I try to laugh about its political 

significance by applying it to funny mechs and 

“Nothing is taken 
seriously in my work. I try 

to mix all the elements 
and create surrealist 

situations”

http://www.2dartistmag.com
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vehicles. Nothing is taken seriously in my work. 

I try to mix all the elements and create surrealist 

situations.

As you say nothing is taken too seriously with 

your work - are you aiming to amuse the viewer 

or convey some other feeling? Or don’t you 

really think too much about the viewer’s opinions 

and just draw for yourself?

Many very talented artists have already painted 

serious and realistic stuff that I admire. Rather 

than copying them badly I prefer to continue 

creating crazy stuff that is very natural for me 

to make! Of course when I draw I think about 

the people who will see my work (especially 

professional people) and that’s why I try to make 

the best picture I can. Having viewers pushes 

me to give the best of myself, and I don’t like 

bad crits - even if I need them and take them 

very seriously [Laughs]! But every picture you’ve 

seen from me is a personal project. I think 

about a scene, I find it cool and fun, I paint it 

and it’s so cool knowing someone took it as the 

wallpaper on their computer! 

If I was asked the one thing I like best about 

your work, I would say it is the colours you 

choose. You seem to have a natural ability 

to pick the most beautiful, yet subtle, colour 

palettes - can you tell us a little more about this?

Wow, thanks for that! I wouldn’t say it’s a natural 

ability; when I paint I take a lot of time trying out different colors and 

mixing layers - it’s probably the longest part of my work. I wish I could 

decide before starting a work what my palettes will be, but they’re always 

changing at different stages. Actually I always come back to the same 

palette. I don’t know yet if I like it like that or not, but there it is! And if you 

like it, maybe I should continue this way.

“Actually I always seem 
to come back to the same 

color palettes”

http://www.2dartistmag.com






page 14www.2dartistmag.com Issue 045 September 2009

Interview  Guillaume Menuel
There are lots of cute robots running around 

in your portfolio. Why do you love to paint 

them and what are your influences for these 

characters?

It definitely comes from my interest in Manga, 

Japanime and SF movies. I guess my interest 

in robots came from the same reasons as 

everyone else who draws robots. I like to draw 

them because of their graphical malleability: 

you can do what you want with their shapes. 

But it also a lot of fun to be able to give them 

a personality with very few details; sometimes 

you can make them much more expressive than 

humans. They tend to be cute in my drawings, 

because as I said previously, I don’t take things 

too seriously in my work.

Have you ever tried any other mediums, such as 

3D modelling, for your robots?

I used 3D for a few years in video game 

industry, but for more than two years now I’ve 

only worked with 2D tools and I prefer that so 

much! I’d love to make a short movie or a video 

game demo based on my characters - that 

would be a good opportunity to come back to 3D 

tools. Well I say that, but I’m actually currently 

working on a picture with a friend (also an artist 

at Ubisoft), which mixes 3D and 2D (he creates 

the models and scene and I paint over it).

I also work a little bit with acrylic on canvas. In 

the past I used to work a little with argyle and 

I’d love to try urban painting and make my mech 

army invade city walls!

Your images “Red Star and Bikini” and “Beach 

Robots Attack” have a lot of similar elements. 

Are these images based on anything in 

particular?

Not really, they both present a vision of an 

apocalyptic world at war, where a stupid army 

full of mechs and big vehicles decides to invade 

beaches because there’s sun at the beach, you 

know... but bikini-clad girls won’t let that happen! 

Maybe the script for a comic or something else? 

Who knows [Laughs]!

http://www.2dartistmag.com


Your image “Miami” was one of our favorites to be published in our book 

Digital Art Masters V3. How did you find this whole experience?

This experience was great! It was the first time my personal work had 

been professionally published, so I was really excited about it. It was even 

more exciting that I had the opportunity to explain the background of my 

picture and how I worked on it. I didn’t have time this year to participate to 

the new volume of Digital Art Masters, but I’ll be there next time!

I’m going to hold you to that Guillaume! Call for entries will be around 

October some time and I’m expecting to see some red bikini-clad girls 

chasing some crazy robots! Thanks again for your time and it’s been great 

chatting, Tom.

Thanks to you too! I’ll be there in October and stupid robots will definitely 

be there trying to conquer the world!

Guillaume Menuel
For more work by this artist please visit:

http://gmgallery.blogspot.com/

Or contact them at:

guigui_oni@hotmail.com

Interviewed by: Tom Greenway

http://gmgallery.blogspot.com/
mailto:guigui_oni@hotmail.com
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“Digital Art Masters is getting 
better and better at showcasing 

some of today’s best digital 
artists. The way the book shows 

the processes of achieving 
great pictures provides a good 

opportunity to learn from these 
artists, and keeps you challenged 

in your own Art.”
Raphael Lacoste | www.raphael-lacoste.com/
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“The sketch phase is my 
favorite because it allows 
me to go crazy with shapes 
and value without thinking 
about anything specific, 
and it allows me focus on 
composition”
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Cliff Childs Sketchbook

Sketchbook of 
Cliff Childs 
 
Characters
With my quick sketches I usually have a 

direction I want things to go in, and the main 

theme for these was to come up with something 

odd and interesting by combining weird 

creatures with human qualities (Fig.01a – 02b). 

I started with some loose line drawings, working 

directly on the Wacom tablet, and then blocked 

in light and shadowed areas. Once I was happy 

with the creature and the pose, I worked out the 

values a little more whilst thinking about light 

direction. 

“Overlaying photos of food or skin is a great 
way to find interesting color variations”

When moving to color I like to first use Overlay, Soft Light, and Color 

layer blending modes in Photoshop so that I keep some detail from 

the grayscale. Overlaying photos of food or skin is a great way to find 

interesting color variations – once I see a set of colors that I really like, I 

usually color-pick from there to finish building up my characters.

http://www.2dartistmag.com
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Grayscale to Color
A great way of starting color is to lay down some base colors just to help 

set the tone and mood. In the tank and sci-fi sketches (Fig.03 – 04), I took 

any random photograph that had a great set of base colors (like a desert 

for the tank and an underwater picture for the sci-fi piece) and played with 

the layer types in Photoshop until I found something that looked good 

whilst not washing away my sketches. I sometimes blur the photos until 

they become just smooth colors. In 

the sci-fi sketch I made a stroke of 

color under the Color Dodge layer 

to create a glowing light effect, and 

then duplicated that to create beams 

of light. If I see some section or 

piece of a sketch that is interesting, 

I like to duplicate just that section 

and transform it in other areas of the 

sketch to add some repetition and 

continuity.

“I sometimes blur the photos until they 
become just smooth colors.”

http://www.2dartistmag.com
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Sketches
Most of the time, I find the best way of coming up with an idea is to just 

randomly throw down interesting brushstrokes/shapes and only focus on 

making the values and composition work. I will usually then begin to see 

something that will spark an idea of what kind of direction I want to take it. 

Using shape tools and the Lasso Tool is a good way to start a man-made 

environment, and loose texture brushes are a good way to start something 

that looks natural and organic. Sometimes starting with random photos 

causes me to create something that I never would have thought of, and it 

also helps for setting a solid perspective. In the industrial sketch (Fig.05), 

I started with a picture of screws, nuts, and bolts and turned that into a city 

– randomizing is a great way to help me look only for interesting shapes 

within a photograph.

“Randomizing is a great way to help me 
look only for interesting shapes within a 

photograph.”

http://www.2dartistmag.com
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The sketch phase is my favorite 

because it allows me to go 

crazy with shapes and value 

without thinking about anything 

specific, and it allows me focus on 

composition. My ideas usually come 

to me as I paint; I hope that my 

sketches lead to images that look 

different and interesting. Instead of 

making something recognizable into 

something interesting, I try and start 

with something interesting and then 

make it somewhat recognizable. 

That way it has more originality!

Cliff Childs
For more information please visit

http://cliffsconcepts.blogspot.com/ 

or contact

cliffchilds@gmail.com

http://www.2dartistmag.com
http://cliffsconcepts.blogspot.com
mailto:cliffchilds@gmail.com
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http://www.2dartistmag.com
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“I constantly have a 
feeling that the music is 
just going to burst out 
of my chest at any point 
with an intensity I can’t 
control. I keep myself 
on edge, never letting 
myself explode, because 
I know I would lose all 
touch with reality if it 
ever came out all at 
once like that.”

Nykolai Aleksander, CG artist, close friend and co-collaborator in Justin’s “Synaesthesia” project, took some time to 

sit down and talk to Justin about all the things that make him tick, and discover a side to him that may yet be unknown 

even to hardcore Lassen fans.
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Beyond Synaesthesia
An interview with musical mastermind, Justin 

Lassen

Introduction
His scores sound like 

“a giant pot filled with 

Enya, Aphex Twin, 

Philip Glass, Danny 

Elfman, Blue Man 

Group, and Nine Inch 

Nails swirled together until there is a black goop 

burning at the bottom of the fire while steaming 

piles of James Horner, Charlie Clouser and 

Rachmaninov flow into the atmosphere…” - or 

so it has been told. 

But Justin Lassen, who has worked with 

celebrities such as Madonna, Robert Miles 

and Nine Inch Nails to name but a few, is more 

than just another composer. He is a visionary 

in the true sense of the word. He’s a dreamer 

with a knack for the dark and mysterious (no 

doubt something that runs in the genes, being 

a direct descendent of one of the famous 

Grimm Brothers), as well as someone who has 

managed to stay with both feet firmly on the 

ground. 

An Interview with Justin, 
by Nykolai Aleksander
Hi Justin! First I want to thank you for doing this 

interview! I’m all excited … I’ve never done this 

before, so let’s hope I won‘t screw up too badly! 

OK, how about we start with the usual stuff: 

Could you tell the readers a bit about yourself?

Hello, and thanks for having me do this 

interview! 

Well, I’m a generally type casted as a dark artist/

composer/remixer/producer/musician, but I am 

also many other things. I work in a lot of different 

industries like films, videogames, music, radio, 

media, etc. doing a lot of different odd jobs 

and things. Not all of it is music or graphics; 

sometimes it’s just spreadsheets and business 

plans, or presentations for talks at schools or 

pitch meetings. Whatever the project is, I just 

make sure to do the best I can. 

I was born in Colorado but mostly grew up in 

Arizona, and I’m 100% self-taught musically, 

though I was in any school choir I could get in, 

all my life during those years (tenor). [Smiles]

http://www.2dartistmag.com
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Aside from apparently always having a love for 

music, what else did you do when you were 

growing up – any hobbies worth mentioning? 

Any dream jobs you thought up as a kid?

Growing up, I was either all in, or not at all. 

There was no half-way of doing things in my 

eyes. If I couldn’t give it my all, I wouldn’t try at 

all. I didn’t see the point. I had to figure things 

out to the fullest. 

When I was into science and chemistry, I didn’t 

just get a chemistry set, I got 10, and I ordered 

from the real chemistry lab catalogues – new 

beakers and test tubes and such. When I was 

making films, I took advantage of my family’s 

cameras to the fullest, from VHS to JVC 

to MiniDV; I grew with the technology as it 

progressed and created dozens of short films, 

as I wanted to be a director one day. When I 

was into computers I learned Basic, Pascal, C/

C++, Visual Basic, and whatever else came 

along. 

When the internet started I made it a point to 

learn Perl/HTML/JavaScript, etc. I learned even 

technologies that are obsolete today. I don’t 

do as much programming or any of that stuff 

because music became my true love. 

When I wanted to be a magician, I didn’t just 

learn a few tricks, I took magic classes, I bought 

tons of books about tricks, I dreamed of one day 

“When I was into writing plays, I got all the 
neighborhood kids and put together productions for 

all the parents at my house.”

http://www.2dartistmag.com
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having a show, I put on shows. When I was into 

writing plays, I got all the neighborhood kids and 

put together productions for all the parents at my 

house. There was so much I did younger, and 

did to the fullest. I have no regrets. I like who I 

have become.

One dream that I would love to return to one 

day is marine biology. I’ve always had fantasies 

about the sea and oceans, and snorkeling for 

the first time in Cancun last year really re-ignited 

that spark inside of me. I think the oceans are 

the most beautiful things that we have on Earth. 

I love underwater documentaries and deep sea 

exploration. If in the apocalyptic future when I 

can’t make the music I love, I would return to 

that kind of work and keep learning as much as 

I can. 

Even as a composer, I read so many books 

and learn so many things; I think life is my 

university and there is never a graduation date. 

I love documenting and archiving, which yet 

another passion of mine. I try to theorize how 

we as a people will be able to save all of our 

digital memories. This technologically advanced 

society cannot go on forever, and maybe one 

day this and all record of it will be lost and future 

generations will have to start over from scratch 

again? Maybe we’ve been through this cycle a 

few times? This idea fascinates me.

How did you start in the music industry? Was it 

a slow process, did you actively seek work, or 

were you discovered in some way?

I was always fascinated with digital music 

creation from the mid 90s, but it wasn’t until the 

late 90s I started taking it more seriously as a 

career, as opposed to a hobby. That proved to 

http://www.2dartistmag.com
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be the best choice I ever made. You have to 

give it your all, or nothing will happen. 

At first I didn’t know what to do; I sent out 

random demos to tons of labels (this was 

before we had MySpace and things like that). 

It didn’t quite work, but ultimately I got my first 

industry gig from one of my heroes, Robert 

Miles, a brilliant platinum composer/artist that 

I was listening to for ages. After working on 

that project I started to get noticed by everyone 

and one thing lead to another … and here I am 

today.

For the technically inclined readers, what kind 

of programs do you work with, and what kind of 

computer power do you have at your disposal?

Believe it or not, I started making music on a 

286 computer, at 33MHz and just 2MBs of RAM 

with software like Midisoft Recording Studio 

and Cakewalk. Over the years I’ve gotten more 

powerful machines as they’ve come out. I 

divide my time between two types of composing 

processes: mobile and desktop. I do a lot of 

travel around the world, so the last few years 

has required me to have kick-ass laptops, filled 

with the best sounds to jot down all my ideas, so 

it’s usually Centrino systems. My current laptop 

is a Core2 Duo 2.8GHz, 4GB RAM – plenty to 

get a bunch of work done. 

My stay-at-home desktop workstation is an Intel 

Core i7 Extreme Edition running at 3.2GHz and 

all the RAM and hard drive space I could ever 

need. Between the two, I have enough power to 

do all kinds of projects and styles. I use software 

such as FL Studio, Sonar, Acid, Sound Forge, 

and so on.

Many of us frequenting the CG scene will know 

about your “Synaesthesia” project, a series 

of compositions that not only accompany CG 

images by various artists, but are the essence 

of those images in sound. You were the first 

to combine the two art forms. What was it that 

made you do it, and how does it feel to be the 

“founding father”, as it were, of a new art form 

altogether?

Well, right after I invented the internet, I decided 

that it needed a new art form, so I very quickly 

put it together in a very founding-fatherly way. 

“... that’s when I felt my first sincere connection with a 
CG artist’s vision...”

http://www.2dartistmag.com


[Laughs] Just kidding! But for real, there was not 

any intention to create something new like that. I 

was just as mesmerized by the end result as the 

fans when it was all said and done. 

I was staring at a beautiful painting by Martin 

Bland in 2005 called “Medusa Fields”, which I 

fantasized for a while about, and after reading 

the description of it, “30 years have passed, 

still the epitaph of past conflict stands, the 

legacy of that fateful day, when the weapon 

was deployed, a permanent reminder of our 

failings, a permanent lesson for future society, 

these fields are sacred, doomed, cherished” I 

was hooked. I had goosebumps; I had felt its 

soul. At first I knew what was going on in the 

scene, but when I read the confirmation and it 

was just as I imagined, that’s when I felt my first 

sincere connection with a CG artist’s vision, and 

a beautiful string piece played out of my fingers 

like a ghost playing or something. I knew I had 

something special when I heard it played back. 

The CG artists tend to ask, “How did you know 

what was in my head?” After the first series 

was released, I knew I had something special, 

unique and original on my hands; to have been 

the world’s first and still only composer to be 

front cover featured and celebrated on most of 

the top CG websites and magazines, was not 

only a huge honor (because I respect CG artists 

to the core), but also very humbling. I get so 

many supportive mails from CG artists and fans 

who all say my music has helped them in some 

way, which makes it all worth it.
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Could you briefly explain the process of writing 

music for images? What is it that triggers you to 

want to write a piece for an image? How does 

it start?

This is a good question. I think the thing to keep 

in mind is that not every image makes me feel 

like composing. I think the thing I look for in a 

work, is the soul. I look for mythologies built into 

the setting. Not just colors triggering notes, but 

worlds that I feel could actually come to life. If I 

can’t immediately see the soul, it doesn’t mean 

it’s not in there, it’s just that I must be blind to 

that vision. [Smiles] 

To me, the magic part about writing for images 

is that there is no process at all; if it triggers me 

to compose, it does it instantly and there’s no 

complicated nonsense in the way, no step by 

step. The music will just flow from my fingers 

to the keyboard, or whatever instrument I’m 

playing at the time, almost instantly, and I 

immediately become transported into that world. 

The image becomes my desktop wallpaper and 

I live with that vision while working on the music 

for as long as I need it. I am a world traveler 

I guess, and I don’t mean just here on Earth. 

[Winks]

If you could start over with the “Synaesthesia” 

project, is there anything you would do 

differently?

Interestingly enough, there wasn’t a big 

mischievous scheme, no product was designed, 

no business plan; it was quite literally just my 

love for art, and especially CG artists and CG 

communities around the world. 

I suppose maybe it would have been smarter 

to productize it much sooner or create a more 

central hub for the fans, but would that have 

been a wise decision? Would it have cheapened 

it? Or did it happen as it was going to happen, 

no matter what? I suppose the magic of 

discovering my Synaesthesia series, is the 

discovery part of it, itself. 

I don’t know the answers to these questions. I 

think I’m happy with the way the project worked 

out all these years, and all the fans I got from 

it. I think they can tell it was my heart speaking, 

and sometimes crying, and not me inspired by 

my need for survival.

That reminds me of a beautiful quote I once 

heard about music that “it is not about what 

you hear, not about the notes played and the 

melodies consumed, but about the empty 

spaces, the silence in between that makes it 

sing.” – Any thoughts on that? What would you 

say if asked to describe music in one sentence?

I agree with that statement. I think there are 

all kinds of impressive musicians in the world; 

some who can shred a thousand notes a 

second on a guitar in melodic death metal, or a 

pianist virtuosi playing the keyboard at such an 

intensity, as if he or she has six fingers on each 

hand, or seemingly four hands total – much like 

the hero in the film, “The Legend of 1900”, when 

he was showing up that jazz pianist in the final 

“battle” scene. 

I don’t have my head in the sand on these 

matters. I, of course, think that is a very 

“I would describe music 
as oxygen; if you lose too 

much of it, you die.”

http://www.2dartistmag.com


impressive feat, but I don’t necessarily draw 

a personal or deep connection with that sort 

of complicated stuff. Bach is incredibly genius 

and talented, and so complicated with his 

“inventions”, yet Beethoven’s Moonlight Sonata, 

which has tons of blank space and room to 

breathe, can touch me more? Why do I love 

Samuel Barber’s “Adagio for Strings” choral 

arrangement? Because it is simply beautiful, yet 

full of complexity in other ways. 

I would describe music as oxygen; if you lose 

too much of it, you die. Get your fix whenever 

you can, because maybe one day we won’t 

have this much accessibility to music…
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It’s interesting that you mention Beethoven, 

because that quote was made about his 

music! Anyhow, what would be your dream 

environment or conditions to work in? Honestly. 

No holding back.

I’ve always fantasized about being kinda in the 

same situation as the main character in Charles 

Dickens’ “Great Expectations”. I dream of some 

random lawyer/patron of the arts/rich/illuminated 

type who would like to remain nameless, whom 

I don’t know or ever heard of, to set me up in 

a sacred and gifted place with all that I need, 

and access to ensembles and instruments and 

costumes to boot. I can imagine waking up in a 

castle somewhere with all the proper amenities, 

no bills, not a typical care in the world – just 

music and creation and collaboration and 

experimentation. 

I often wonder what it must feel like to be a “trust 

fund” kid, or generally people who could do 

anything, but choose not to. I know a lot of these 

types of rich people who don’t appreciate their 

own “wealth” or use it to their advantage; they 

seem to just live from one day to the next trying 

to blend in. Musically, I feel like all that I’ve given 

the world is only but a taste, even to me. It was 

a tease, a mean joke on myself. 

I often cry myself to sleep thinking of all the 

symphonies in my head and in my dreams, and 

I constantly have a feeling that the music is just 

going to burst out of my chest at any point with 

an intensity I can’t control. I keep myself on 

edge, never letting myself explode, because I 

know I would lose all touch with reality if it ever 

came out all at once like that. It could possibly 

be dangerous, like writing four symphonies at 

the same time. I do hope to one day create 

these stories and orchestrated happenings ... 

I know, it’s a selfish and simple dream, but it is 

mine. 

Scenery and environments are so very 

important to me ... I have to live life, and balance 

life and dreams, and most of the time the dream 

suffers to maintain the life. I also wish for a 

gorgeous, very old extended octave (9) stage 

piano. [Smiles]

I have known you for about six years now, and 

I can’t believe I’ve never asked you this, but … 

[Grins] lollipops or ice cream? And what flavor?

That’s an easy one! Ice-cream: mint and 

chocolate chip. [Smiles]

Fizzy or Flat? – Drinks, not ice cream.

[Laughs] Fizzy, or never mind!

Sounds good to me! OK, before anyone thinks 

we’re losing it … in closing, are there any big 

projects you are working on at the moment, and 

what are your plans for the future?

There are always projects – big and small – 

going on constantly, and always on a global 

scale. People don’t realize because I don’t make 

“I live in little “moments” 
of time that transition and 

fade into each other...”

http://www.2dartistmag.com


it apparent on the websites, but I’m constantly 

in touch with all kinds of creative people around 

the world in various countries, dreaming up and 

working on gorgeous ideas and contraptions. I 

am honored and humbled to have earned the 

amount of cool fans I have, big celebrated and 

small obscurities, in the work that I’ve put out 

into the world all these years. I really hope to be 

able to keep putting out more and more work as 

my life continues to progress and I continue to 

write new chapters in this sometimes dramatic 

story I’m eagerly the star character in. 

I wish I could plan for the future like normal 

people, but lately it’s been unfolding in front of 

“When I first heard from Justin Lassen, he didn’t approach me empty-

handed. His efforts were accompanied by glowing references from the 

artists he’d composed his work for already. He had several finished 

spots for me.

“His work shines a new light of inspiration for digital visual artists and 

is the ultimate jamming collaboration for those lucky enough to have 

music composed by him from their images. Many go on to create 

deeper, more voluminous pieces. It was worth revisiting his journey 

on CGSociety.org.

“This leap into aural experimentation continues to bring amazing 

dimensional expansion to visual digital arts. I hope he continues and 

I wish Justin Lassen well.” – Paul Hellard, Editor, CG Society & 

Ballistic Publishing

me, without my permission. I wish I could live 

out of an Outlook Calendar or iPhone like all 

the other normal business people in the world, 

but my days don’t have 24 hours like everyone 

else’s, and my years don’t have 365 days. I live 

in little “moments” of time that transition and 

fade into each other on a constant basis. Now 

that we are beyond the Synaesthesia series, I 

look forward to my future as much as anyone 

else and I can’t wait to see what comes out next. 

I am on pins-and-needles now.

Any last words before we are told to shut up? 

[Smiles]

Never shut up. Always dream!

Justin Lassen
For more information please visit

www.empireofmodernthought.com (website)

http://www.justinlassen.com (blog)

or contact: jl@justinlassen.com

A 2-Disc Special edition CD with all tracks 

from the Synaesthesia project is scheduled for 

release in October 2009. 

Interviewed by: Nykolai Aleksander

For more information please visit: 

http://www.admemento.com/

Or contact: x@admemento.com

http://www.empireofmodernthought.com
http://www.nihilmedia.com
http://www.justinlassen.com
mailto:jl@justinlassen.com
http://www.admemento.com/
mailto:x@admemento.com
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Vancouver Film School congratulates Neill Blomkamp,a graduate of the one-year VFS 3D Animation & Visual Effects program, on his first feature film, the acclaimed District 9!
41 talented VFS alumni helped realize Neill’s innovative vision for what critics are calling “a landmark film”, and we’re proud of all of them.

Exclusive interviews, video, giveaways, and more 
»vfs.com/D9

VFS ALUMNI ON DISTRICT 9

Neill Blomkamp (Graduated 1998)

DIRECTOR & CO-WRITER

Terri Tatchell (2001)

CO-WRITER

Shawn Walsh (1997)

VISUAL EFFECTS EXECUTIVE PR
ODUCER

James Stewart (1997)

CREATURE SUPERVISOR

Robert Bourgeault (1997)

LIGHTING LEAD

Derek Stevenson (1998) 

MATCHMOVE LEAD

Brett Ineson (1996)

MOTION CAPTURE SUPERVISOR

Christopher Ahrens (2006)

LIGHTING ARTIST

Geeta Basantani (2001)

COMPOSITOR

Peter Benson (1999)

MOTION CAPTURE ACTOR

Jelmer Boskma (2006)

MODELER

Freddy Chavez (2005)

VISUAL EFFECTS COMPOSITOR

Dominic Cheung (2005)

LIGHTING TECHNICAL DIRECTOR

Paul Copeland (2005)

VISUAL EFFECTS ARTIST

Anthony Di Ninno (2006)

ANIMATOR

Ian Fenton (2001)

COMPOSITOR

Brian Harder (2000)

CREATURE RIGGER

Nathaniel Holroyd (2007)

VFX COORDINATOR

Bernhard Huber (2006) 

EFFECTS ANIMATOR

Steve Johnston (2006)

RENDER WRANGLER

Patrick Kalyn (2001)

ANIMATOR

Bernhard Kimbacher (2007)

VISUAL EFFECTS DATA COORDINA
TOR & COMPOSITOR

Julianna Kolakis (2006)

CREATURE TEXTURE PAINTER

Veronica Marino (2006)

COMPOSITOR

Adam Marisett (2005)

VISUAL EFFECTS ARTIST

James McPhail (2007)

VISUAL EFFECTS TECHNICAL DI
RECTOR

Nikolai Michaleski (1997)

COMPOSITOR

Jacob Miller (2006)

MATCHMOVE ARTIST

Francisco Moncayo Moreno (2007)

DIGITAL EFFECTS ARTIST

Brendon Morfitt (2004)

DIGITAL ARTIST

Fernando Pazos (1996)

ANIMATOR

Dan Prentice (2004)

CG ARTIST

Mike Rhone (1999) 

VISUAL EFFECTS ARTIST

Cynthia Rodriguez del Castillo (
2007)

DIGITAL PAINT & ROTO ARTIST

Cesar Rodriguez Bautista (2006)

DIGITAL PAINT & ROTO ARTIST

Marc Roth (1997)

VISUAL EFFECTS ARTIST

Ben Burden Smith (1999)

MOTION CAPTURE FIRST AD

Richard Sur (2006)

LIGHTING TECHNICAL DIRECTOR

Anna Tonrungroj (2008)

DIGITAL COMPOSITOR

Grant Wilson (1991)

ANIMATOR

Joey Wilson (2005)

MODELER

Samson Wong (2007)

MATCHMOVE ARTIST

http://www.vfs.com/enterd9


This Month we Feature Image from:

Mateja Petkovic

Florian de Gésincourt

Ioan Dumitrescu

Arnaud Valette

David Smit

Branko Bistrovic

Vlad “Duke” Kuprienko

Pao (Thitipong Jitmakusol)

Randis

Richard Anderson
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Days of Victory
Ioan Dumitrescu aka jonone

(Right)

jononespo@yahoo.com

The Medieval Kingdom
Mateja Petkovic

(Below)

www.matejapetkovic.blogspot.com

sqezavela@gmail.com

Winner of the CGTantra Futuristic Cityscape Matte Painting 

Challenge, sponsored by 2DArtist Magazine

http://www.2dartistmag.com
mailto:lynette@3dtotal.com
mailto:jononespo@yahoo.com
http://www.matejapetkovic.blogspot.com
mailto:sqezavela@gmail.com
http://www.cgtantra.com/
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Futuristic Cityscape - Dubai in 100 Years
Florian de Gésincourt (a.k.a. dges)

http://www.dges.fr; http://dges.over-blog.com

contact@dges.fr 

(Above)

Winner of the CGTantra Futuristic Cityscape Matte Painting Challenge, 

sponsored by 2DArtist Magazine

Xwing
Vlad “Duke” Kuprienko

http://www.3dreamlab.com

admin@3dreamlab.com 

(Below) 

http://www.2dartistmag.com
mailto:lynette@3dtotal.com
http://www.dges.fr
http://dges.over-blog.com
mailto:contact@dges.fr
http://www.3dreamlab.com
mailto:admin@3dreamlab.com
http://www.cgtantra.com/


Awakening
Arnaud Valette

http://www.arnaudvalette.com

arnovalette@gmail.com

http://www.arnaudvalette.com
mailto:arnovalette@gmail.com


The Breath On Your Neck
Branko Bistrovic

http://branko.cgsociety.org/gallery/

bisvic@gmail.com

http://branko.cgsociety.org/gallery/
mailto:bisvic@gmail.com
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Spacesuit
Richard Anderson

http://flaptrapsart.com/

flaptraps@flaptrapsart.com 

(Right)

http://www.2dartistmag.com
mailto:lynette@3dtotal.com
http://flaptrapsart.com
mailto:flaptraps@flaptrapsart.com


Vampire Slayer
Randis

http://www.hd-fortress.com

contact@hd-fortress.com 

 

© Randis Albion 2009 

http://www.hd-fortress.com
mailto:contact@hd-fortress.com


Secret Agent
David Smit

http://www.davidsmit.com

david@davidsmit.com

http://www.davidsmit.com
mailto:david@davidsmit.com




Royal Guard
Pao (Thitipong Jitmakusol)

http://www.iampao.com

iampao@gmail.com

http://www.iampao.com
mailto:iampao@gmail.com


http://www.digitaltutors.com


This tutorial series will revolve around the use of 3d as a starting point for digital painting. In particular we will 

explore the value of Google SketchUp, a free program enabling users to quickly build 3d environments using 

a set of intuitive tools.

This technique is used by many contemporary artists and is used as a quick and effective way of establishing 

correct perspective as well as offering a moveable camera in order to experiment with compositions.

As a 3d package SketchUp is easy to learn and does not require hours of training and as an artist wishing 

to draw complicated scenes, this approach can prove a valuable starting point for producing a template on 

which to paint over.

“…by following along with the steps, 
you will be able to arrive at a similar 

visual conclusion and then get excited 
enough to extrapolate the lessons 

learned into your own pieces of 
artwork.”

• Free Brushes
• Free Base Image

http://www.2dartistmag.com/tutorial_resources/issue_045_sep_2009/tutorial01/tutorial01_sep09.zip
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Using 3D as a Base for 2D Painting Part 3: 

Using Google SketchUp as 
a base for Digital Painting

Why use SketchUp?
Google SketchUp is a free programme enabling 

users to quickly and effectively build 3D 

environments using a number of intuitive tools. 

Unlike most 3D packages it is very easy to learn 

and does not require hours of training before 

decent results are achievable. It is very versatile 

and with regards to digital painting can prove an 

invaluable tool in swiftly establishing a correct 

perspective, as well as offering a moveable 

camera in order to experiment with alternative 

viewpoints and compositions. 

An object can be made and then duplicated 

any number of times, so if a structural element 

is repeated throughout your concept then this 

package can quickly and accurately create 

such arrays. It also has a simple-to-use lighting 

system that enables placement of the sun 

according to the month and time of day by 

way of slider bars, thus determining physically 

correct shadows that can be turned on or off at 

the click of a button. These functions mean that 

as an artist wishing to draw detailed or tricky 

scenes, one can use SketchUp as a valuable 

starting point to establish a “guide template” on 

which to paint over.

Installation
In order to install SketchUp, click on the link 

below and go to Downloads on the left hand 

menu. Select the free version which is currently 

version 7 (Fig.01). Choose your operating 

system and then follow the instructions. 

http://sketchup.google.com/

Once installed, click on the application shortcut 

and you will be prompted with the following 

dialogue box in which you are asked to choose 

a template (Fig.02). The scale and type of your 

scene will determine which you choose, but 

for the purposes of this tutorial we will select 

Architectural Design – Feet and Inches.

Toolbars & Menus
When SketchUp starts you will see a screen 

resembling Fig.03. From the main menu click 

on View > Toolbars > Large Tool Set; this will 

access more tools which will appear down the 

left margin. To change the display mode of the 

objects in the scene click on View > Face Style; 

this will show a number of options, as seen in 

Fig.04.

If you also check Views under View > Toolbars 

you will see six small house icons appear 

below your toolbar (Fig.05). These will provide 

quick access to orthographic views, as well 

as isometric. You will notice that I have also 

checked Face Style in the list (highlighted in 

green), which has added some cube icons to 

represent the display modes. 

This is basically where you can customise your 

workspace and add toolsets to speed up your 

workflow. For additional help go to Window > 

Instructor; this will open a window providing 

useful information on whichever tool you have 

currently selected.

http://www.2dartistmag.com
http://sketchup.google.com/
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Basic Navigation
The key orientation tools you will use to navigate 

in your scene are Orbit, Pan and Zoom, which 

you will find on the top toolbar and whose 

shortcut keys are represented by O (Orbit), 

H (Pan) and Z (zoom). These can be seen in 

Fig.06.

The main tools used to directly manipulate your 

objects are Move (M), Rotate (Q) and Scale (S). 

The Scale tool appears on the left hand toolbar 

which you will see highlighted if you press S on 

your keyboard.

Drawing Shapes
One way of using SketchUp is to create two-

dimensional shapes from which you can extrude 

three-dimensional objects. Select the top view 

and then the Line tool (Fig.07) and left-click in 

the viewport to begin drawing. You will notice 

that as you do so, the points will snap to the 

green and red axes, thus easily enabling the 

creation of right-angled structures.

When you finally close the shape by clicking on 

the initial point you will notice the shape turns 

blue, indicating a surface has been made; once 

a shape has become closed you can still edit 

it, however. Using the Line tool, add an internal 

rectangle (see top diagram in Fig.08). To now 

make this edge become part of the exterior 

shape click on the Eraser tool and then on the 

outside edge shown in red.

You can continue to cut into your shape or 

alternatively extend it outwards and then erase 

the necessary lines by using the Line tool 

(Fig.09). Here I have added a walkway and 

also a curved section using the Arc tool. You 

can also draw more organic shapes using the 

Freehand tool (Fig.10).

One other useful function, especially for 

architectural structures, is the Offset tool which 

is situated next to the Rotate tool. This enables 

a shape to be duplicated in order to create 

depth – perfect for drawing walls in a building, 

for example (Fig.11).

With an exterior wall depth, click on the large 

internal shape using the Select tool (black arrow 

on Toolbar) and hit delete. You can then select 

the Push/Pull tool and then click on the wall and 

raise it vertically (Fig.12). You will notice I have 

edited the section where the walkway adjoins 

http://www.2dartistmag.com


page 53www.2dartistmag.com Issue 045 September 2009

Using 3D as a Base for 2D Painting Part 3: 

To add lighting effects check Shadows which 

is above the Fog label, and to get more control 

over this function go to View > Toolbars > 

Shadows. This will place two slider bars on your 

toolbar which denote the month and time of day. 

By adjusting these you can control the position 

of the sun and direction of the shadows (Fig.16). 

There is a little icon to switch the lighting on or 

off, and besides this there is also another icon 

which opens up some extra parameters that 

the building using the Line and Eraser tools so 

that this was not raised along with the outer wall.

Three Dimensions
When a shape has been converted into 3D it 

can be edited further by using a combination 

of the Line and Push/Pull tools. If you move 

the Line tool along an edge it will snap to the 

midpoint between opposing edges (Fig.13). You 

can then make equally spaced cuts, as shown. 

These new shapes can be pushed inward or 

pulled outward, or alternatively a new shape can 

be drawn and this can then be manipulated.

In Fig.14 I have used the Offset tool to create 

a window shape in the far left rectangle. To 

create the same proportioned window in the 

other sections simply select the Offset tool 

and double-click in each rectangle. To create 

the arches use the Arc tool and then erase 

the horizontal join shown by the dotted line. 

To create windows use the Push/Pull tool to 

move the shapes inwards beyond the inner wall 

surface or until they disappear. 

Using a combination of the tools mentioned 

so far you will have the means through which 

to create and edit a wide range of forms and 

design detailed scenes.

Atmospherics & Lighting
You can add atmospheric perspective in the 

form of fog to your scene. Go to View and check 

Fog, as seen in Fig.15. You will notice that the 

edges on my building have also been switched 

off, which you can control in the menu under 

Edge Style > Display Edges.

alter the tonal range of the shading. You can 

also control whether this affects just the object 

itself or the ground along with it and vice versa.

Additional Tools
A few other useful tools worth mentioning are 

the Tape Measure, Protractor and Dimension. 

The Tape Measure is used to draw guidelines 

which can then be traced over with the Line tool. 

In Fig.17 you can see that the tape measure 
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has created the dotted lines which can be 

used as a guide to draw the windows an equal 

distance from the top and bottom of the block. 

To delete the lines simply use the Eraser tool.

The Protractor is used to create accurate 

angles. Move the tool to the point at which you 

wish to start the angle and you will see how it 

snaps to the three axes. Click to establish the 

correct plane and then click to begin the angle 

along the appropriate edge. Now you can set 

the angle using the guideline. In Fig.18 I have 

used the near corner as the starting point, which 

I will mirror on the opposite corner.

Once the guidelines are drawn, trace them 

using the Line tool, as with the Tape Measure. 

In Fig.19 you can see that the two angles have 

been drawn and then the Push/Pull tool was 

used to extrude a roof shape across the base 

block.

The Dimension tool simply adds a label to 

your scene, showing the distance between two 

points. Click and drag from A to B and then drag 

up or down to set your dimensions, once again 

using the Eraser tool to delete when necessary 

(Fig.20).

Cameras
The camera in SketchUp is initially placed at an 

average eye level height, so for example when 

you click on the Position Camera tool it will 

zoom in and appear around head height from 

the ground. In this sense scale is an important 

factor in your scene. 

In Fig.21 you can see a cross where I intend to 

position the camera, after which the viewpoint 

will resemble the inset image. The character has 

been placed in the scene to demonstrate the 

relationship between the scale of a character 

and the initial camera height. To adjust your 

camera, use the Look Around tool represented 

by the eye icon.

One final tool which may prove useful is the 

Section Plane tool which allows a view of a 

cross-section of your object. To use this click 

on the tool and then align the green icon to the 

corresponding plane or angle you wish to view. 

Then select the Move tool and click on one 

of the corner arrows and drag in the relevant 

direction (Fig.22).

This concludes our overview which I hope has 

at least introduced the main tools and their 

functions. There are of course further lessons 

to learn along with other tools and techniques, 

such as applying materials, but the main aim 

here is to introduce the interface and value of 

the software in terms of building a simple 3D 

environment which can then be used in digital 

painting. 

Richard Tilbury
For more from this artist visit:

http://www.richardtilburyart.com/

Or contact them at:

rich@3dtotal.com
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you with the final image. My conservative hope 

is that by following along with the steps, you will 

be able to arrive at a similar visual conclusion 

and then get excited enough to extrapolate the 

lessons learned into your own pieces of artwork.

So without further ado, let’s get on with the 

show!

Step 1 
Here we can see the initial base geometry as 

created in Google SketchUp (Fig.01). As you 

can see it is all very rudimentary, although I 

have turned on the shadowing (View > Toolbar 

> Shadows > Display Shadows) as I find it 

is one of the more tedious things to illustrate 

manually.

Keeping the geometry simple is a conscious 

decision which necessarily requires me to add 

in the detail work by hand, rather than slaving 

Therein lays the crux of this tutorial – that is to 

undertake basic scene design, similar to that 

in film or game pre-production, leveraging the 

flexibility and rapidity of using a 3D modeling 

package.

The scene I am looking to create is an area set 

within a third world country, late in the afternoon, 

lending itself to long cool shadows and warm 

object colors. Due to the setting, the piece will 

necessarily include the use of texturing to bring 

a visceral feel to the world, and I’ll be using a 

lot of earthy colors and an execution that will be 

quite painterly with an abundance of application 

strokes. This is in stark juxtaposition to sharp 

clean lines, which is an inherent pitfall when 

painting over perfectly rendered polygon edges.

My focus is to impart procedure and technique 

that will be applicable across all manner of 

subject matter and era, not necessarily to wow 

Using 3D as a base for  
2D Painting
Software Used: Google SketchUp and 

Photoshop

Introduction
Designing environments in a three-dimensional 

space incorporating lighting cues, mood, and 

spatially representing objects in relation to 

one another are important skills in allowing 

the art department leads to make decisions 

early. Understanding perspective and volume 

in three dimensions are essential to being able 

to successfully undertake such a task, but 

it may not always be desirable to start from 

scratch – establishing the horizon lines, plotting 

the vanishing points and then constructing the 

objects in relation to these constraints. 

As in any production environment, time is 

of the essence, and this directly translates 

to the expenses associated with a project 

and additionally increases lead times on 

making decisions. So taking advantage of any 

techniques or skills which can expedite the 

process is very valuable to those involved. This 

is where using a program such as Google’s 

free software, SketchUp can help: it allows 

objects to be blocked out quickly and efficiently, 

convergence is automatically taken care of, 

rapid prototyping of various object placements 

can be undertaken, and complex repeating 

elements can be duplicated in a split second.
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convergence lines based upon existing parallel 

lines within the image (Fig.03). 

The reasons they are important, especially 

if there is no visible horizon line (such as in 

this image) is that you have a tangible idea of 

how the geometry is spaced according to one 

another, and also to act as useful guides for any 

hand drawn elements or textures that also need 

to tend towards to pre-existing convergence 

points.

Step 4 

The next step is to decide what underlying color 

the image should have. In this case I’ve decided 

over the 3D base geometry for hours. I have 

found that spending inordinate amounts of time 

on the modeling beholdens me to the base 

geometry far too much, and I unconsciously 

don’t want to lose a lot of the details that I have 

already modeled, regardless of whether they are 

working to enhance or detract from the image.

As a general rule I spend as much time as I 

need to block in the major shapes, but as little 

time as possible. To illustrate, this work done in 

SketchUp took approximately 10 minutes.

Step 2
When the base modeling has been created, 

I bring up the Styles dialogue box (Window 

> Styles) which allows me to alter the style 

from the generic SketchUp modeling style into 

something that will help my painterly style later 

on. In this case, I choose the PSO Cursive style, 

which adds a background texture resembling 

that of pencil texture on paper, and the lines 

also look like ruled graphite (Fig.02). Overall, it 

looks less computer generated and will help in 

the rendering of the image.

Once this step has been done, I export the 

image as a JPEG (File > Export > 2D Graphic) 

and save the SketchUp source file in case I 

need it later on.

Import your JPEG file into your illustration 

software of choice – I use Photoshop – and 

ensure you’re happy with the dimensions you’re 

working with.

Step 3 

My first step in all perspective based works is to 

immediately draw up, on a separate layer, any 

on an earthy or sandy colored ground, and I’ve 

used a slight gradient applied to a separate 

layer, with the layer blending mode set to 

Multiply (Fig.04).

It’s important to note which way the predominant 

light is coming from so that the gradients can 

reflect this. I chose a sun position that is coming 

from the upper left of the image, which also 

has a low angle over the horizon which will 

lend to some long shadows that can be used 

to cast over the foreground objects, providing 

unity, describing form and allowing for a more 

dramatic composition.
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have effectively textured part of the image in 3D 

space.

Step 7 

Obviously it would not do for the texture to be 

intersecting with the other foreground elements, 

Step 5 

I choose to texture the ground early on; I see it 

as a relatively unchanging element throughout 

the image, so establishing some basis of what 

everything else is built on is a logical first step 

for me.

This is the base texture I’ve decided to use 

(Fig.05). I did a quick search on Google, and 

for the purpose of quickly texturing something 

this is quite sufficient – yes, it has repeating 

elements, and no it is not a perfectly tileable 

element, but a lot of these imperfections can be 

removed very rapidly by painting them out.

Step 6
Create a duplicate of the texture (Layer > New > 

Layer via Copy) (or Ctrl + J), and hide it so you 

can reuse it later.

Using the duplicated layer, perform a Free 

Transform to place the texture into perspective. 

This can be done by going to Edit > Free 

Transform (or Ctrl + T) and holding the Ctrl key 

while dragging a control handle.

In Fig.06 I have aligned the texture’s edges to 

the guidelines we set up earlier, and now we 

so we necessarily need to start cutting out 

segments of the texture image.

In order to do this, reduce the Opacity of 

the texture layer to 30% so you can see 

the underlying objects, and then, using the 

Polygonal Lasso Tool (Click and hold on Lasso 

Tool in the tools palette and then select the 

Polygonal Lasso Tool), select the areas to be 

cut out. Once you are happy with the selection, 

hit the Delete button (Fig.07).

Step 8 
In order to take advantage of the underlying 

colors of the image, the layer needs to be set 

to an alternative blending mode, so choose the 

Screen mode.

You will notice that the texture lightens the 

ground (Fig.08). For now, this is fine; your aim 

here is just to apply some texture to the ground 

which helps in the illusion of a receding ground 

that is converging into the distance.
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Step 9 
Using the preceding four steps, you can now 

complete the texturing for the entire ground 

plane (Fig.09).

Step 10 

We are looking to achieve a painterly rendering 

style in this piece. As a result, a helpful step I 

often include when I am working in this style is 

creating the rough application of paint with a 

custom made palette knife type brush that I use 

for this task (free for download with this article – 

just click on the Free Brushes icon) (Fig.10).

This helps to break up continuous and uniform 

color with textured strokes, and also works to 

reduce the adherence to the perfectly straight 

lines from the 3D render. I pay particular 

attention to the walls, where I consciously bough 

and roughen up the edges to allude years of 

wear and tear by the elements.

I also start to rough in some color here, making 

sure I keep the saturation of these colors low.

Step 11 

At this stage, I want to start adding in the semblance of detail, alluding to 

things such as signs, shadows being cast from elements outside of the 

visual extremities of the image, and shade cloth over windows.

I use a soft edged brush for this task (Fig.11). I tend to use Airbrush Soft 

Round for general purposes when I have no pressing need for other 

effects – it’s a fast brush, good for approximating form.

Step 12 

When I am happy with the image’s overall composition, I then create a 

duplicate summary layer.

A duplicate summary layer is essentially a layer above all other layers that 

is created if you flatten all the prior layers and then create a duplicate of 

that layer. I do this as a way of shifting my tonal range into something a 

little darker (Fig.12).
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Step 14 

Next is another iterative pass at adding in more 

detail to fill up those areas which seem a little 

sparse, punch up some of the colors, and to 

work in some lighter color around the top of the 

central structure to create a bit more contrast in 

order to draw the eye (Fig.14).

In order to do this, all you need to do is use the 

command, Ctrl + Alt + Shift + E.

Once this is done, set the layer blend mode to 

Multiply and Opacity to 100% – you will notice 

the image darkens quite considerably. The 

reasoning behind this is that your lighter colors 

will have more “punch” to them when you start 

working them back into your image.

Step 13 

This step focuses on increasing the depth of the 

shadows; alluding to some ambient occlusion 

around the base of objects and working in 

some slight vignette effect towards the outer 

extremities are the main areas of focus (Fig.13). 

Using the Airbrush Soft Round suffices for these 

tasks.

Step 15 

Still adding in more detail here, I’m 

concentrating on filling in the colors of the 

shade cloth and adding miscellaneous objects 

underneath some of the covering, placing 

various pipes on the tops of buildings to break 

up their silhouette (Fig.15).
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Step 16
I feel the image needs the focal point to be 

made more apparent, so I again refer to creating 

a duplicate summary layer and setting it to 

Multiply. Erase the lighter side of the building

and around the lighter parts of the ground, to 

show that the light is being cast strongly from 

the left (Fig.16).

Step 17 
This is another iterative detail adding step now. 

I take care to balance where I am placing the 

objects; I like to work the image up as a whole, 

rather than working on any one individual area 

at a time (Fig.17).

A major addition is the slanted roof on 

the middle structure, not because of any 

requirement other than I think it makes the 

viewer ask, “Where on earth is this place?!” Plus 

it also looks kind of cool.

Step 18
At this stage, I am comfortable enough with how 

the image is coming along to start sharpening 

up the details on the central structure and the 

surrounding areas, like the tops of buildings and 

the cloth coverings (Fig.18). 

This is essentially a process of zooming in and 

using a much smaller Chalk brush to work in the 

details. When you zoom back out to the regular 

viewing size, the image will be much clearer and 

sharper.

Step 19 

I feel that the ground needs an extra level of 

detail here; some extra texturing that will sell the 

surface as dry, cracking ground. So I do a quick 

search on Google and end up with the texture 

as displayed in Fig.19.
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image – such as the harsh shadowing at the 

lower left extremities of the debris and junk.

Conclusion
Although I’d still consider this image a work 

in progress ripe for more refinement, for the 

purposes of this tutorial I have covered all 

the essential steps required to create an 

environmental concept built upon a 3D base. 

Again, I realize that there are repeating 

elements and the tiling is very noticeable, but for 

the purpose required, it is perfectly acceptable. 

In order to use the correct scale, I shrink the 

texture to half the original size and duplicate it to 

create a quadrant.

Step 20 

On the basis of steps 6 and 7, I place the 

texture onto the ground plane and work them in 

by erasing where necessary, desaturating the 

color (it’s the texture information I want, not the 

color) and changing the layer blending mode to 

Overlay.

You can see from this simple step that it adds a 

lot to the surface of the image (Fig.20).

Step 21 – Final 

In finishing off, I replicate a few steps from 

earlier on, such as adding some brick textures 

to some of the walls, adding corrugated iron to 

some slabs of color, and painting over some 

areas which I deemed intrusive to the final 

In all, once you get comfortable with the 

process, you can typically finish one of these in 

around 4 hours – it is then up to the art director 

to determine the level of finish they want.

Darren Yeow
For more from this artist contact them at:

darren@stylus-monkey.com

• Free Brushes
• Free Base Image
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An artist’s brushes have always been a vital part of any painter’s set of tools, and remain the 

single asset that links paint with canvas. As such, they are crucial to how we view and interpret 

an artwork, and they afford the artist with a means through which to convey an idea or feeling. 

This has always been true throughout the history of art, and is no less important within a digital 

context. Software such as Photoshop and Painter essentially combine and fuse paint, canvas 

and brushes into a single tool. However, within this complex set of “tools”, brushes retain certain 

autonomy with their own, distinct set of parameters and presets, offering artists the freedom to 

affect and vary the way paint is applied. This principle of customizing brushes forms the focus of 

this set of tutorials, and aims to show how individual artists exploit these techniques to achieve 

some interesting results!

“…start a whole folder 
on your computer of 

hand-painted patterns 
that you can adjust or 
modify as you please, 
when you please. The 
possibilities are truly 

endless…”

• Free Brushes
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Custom Brushes: Fabrics & 
Lace
Software Used:  Photoshop

Introduction
Seeing realistically painted fabrics and material 

embellishment is always awe-inspiring. We 

wonder how an artist achieved it, managing 

to apply such amounts of details and textures 

without going insane in the process – those 

of us who’ve tried to do it all one stroke at a 

time have certainly had our brush with insanity 

(excuse the pun!). Yes, it is manageable, but 

intensely time-consuming aside from anything 

else.

This is where custom brushes come to the 

rescue.

To use custom brushes for fabrics, embroidery 

and lace embellishments is not quite as simple 

as is may seem at first glance, and still requires 

some time to get right, but it is a lot less 

aggravating than having to do it all by hand.

Are you curious to see how it works? Then just 

keep reading!

Painting Realistic Fabrics 
& Embellishments
Let’s assume you have painted a wonderful 

picture with someone wearing a beautiful ball 

gown, or maybe a pirate in 17th Century thrown-

together garb, or a beggar in torn cotton rags 

… Maybe you want to paint a dancer clad in 

nothing but net and lace, or design a wedding 

dress that will make jaws drop? The picture is 

there, but the details are missing to distinguish 

between cotton and silk, lace and net, wool and 

linen, or give the garments that extra little kick 

with extensive embroidery or exquisite brocade.

You’ve been looking at photos to give you 

inspiration, you have been to textile shops to 

look at the real deal, and even raided your own 

wardrobe to see what certain fabrics look like, 

but you still find it hard to paint it all. Well, you’ve 

been to all the right places. You just forgot to 

utilize what you saw. Go back to the textile store 

and buy a small piece of this and that lace you 

liked, download the free embroidery patterns 

you saw online, get a fashion and fabrics 

book from the library (not for direct copying 

though, since even though the fabrics are not 

copyrighted, the photos of them are), and go 

back to your own wardrobe (or that of a friend 

or relative) and pick out the pieces that hold 

something of interest – maybe a piece of lace 

underwear or net stockings, some torn jeans, a 

chunky knit top or a dress with some nice flower 

prints on it. And now you’re good to go!

Single Pattern
Let’s start with something simple: a single item 

to turn into a brush. Here’s a photo of a T-shirt 

of mine that has a nice flower print on it (Fig.01). 

You can see how I made sure that the piece 

was lying flat, and that I tried to photograph it 

straight from above. That way, we eliminate any 

kind of skewed angles and have as few creases 

as possible, in efforts to avoid the problems they 

may cause later on. 

The first thing we want to do when we open the 

photo in Photoshop is to desaturate it by going 

to Image > Adjustments > Desaturate, unless of 

course the image was taken in black and white, 

like mine. It will be easier this way to optimize 

the image before turning it into a brush. Some 

colors turn grayscale better than others – the 

ones of my T-shirt were unfortunately not some 

of them.

To turn just the flower into a brush, we need 

to get rid of the T-shirt surround – Photoshop 

brushes will use anything that is not white, so if 

we were to turn this current image into a brush, 

we‘d get everything we see in it right now. So 

we need to get rid of everything but the piece 

we want to keep. Adjusting the Levels of the 

photo – Image > Adjustments > Levels – helps 

to get the desired results, making sure that the 

surroundings get as pure white as possible, 

while the flower remains nice and dark but not 

too over-saturated (Fig.02). Too much contrast 

here can make the image look very scraggly 

and too sharp around the corners, which is not 

very desirable.

We can now crop the image with the Cropping 

Tool, trying to get as close to the edges of the 

flower as possible without touching them. We 

can also adjust the crop rotation if we want to – 

sometimes it just works better (Fig.03). Now that 

is done, we can adjust the picture some more, 

if necessary. There may still be some grayish 

tones where there should be white, and we need 

to get rid of those.

We can either do this with the Paintbrush – a 

simple Hard Round one is usually the best 
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option here, with Opacity set to Pen Pressure 

and color to white – or the Eraser Tool (with the 

same settings). When using the Eraser Tool, we 

need to make sure that our active Background 

Color is white. We then carefully paint over or 

erase the bits that need to go (Fig.04). Take 

your time with this, as you want it to be as 

perfect as you can get it! Leaving a bit of light 

gray stippling around the immediate edges of 

the flower is okay; it actually works a lot better 

that way once we use it in a painting, as it won’t 

look all too “cut out”. 

Sometimes it can be easier to invert the 

image’s colors (Image > Adjustments > Invert) 

so everything that was white will be black, and 

vice versa, as it is easier to see that way where 

there’s still some grey areas in the black, than 

in white. All you need to do before turning the 

image into a brush later is invert it again to its 

original colors. And should you work with the 

Eraser Tool, make sure your active Background 

Color is of course black, not white.

Essentially, we are now done, but if you feel that 

the image could use a little more contrast, adjust 

it once more using Levels. You can also use the 

Burn Tool with the Mode set to Midtones to bring 

out some of the dark areas a bit more (Fig.05).

Now the image is ready to be turned into a 

brush. Depending on the size of the image, you 

may have to resize it to be able to turn it into a 

brush. In Photoshop CS, the brush size limit is 

2500 pixels on either side (Image > Image Size).

Simply go to Edit > Define Brush Preset, give 

your brush a name if you like – and you’re done 

(Fig.06 – 07). This kind of brush is useful for 

creating stand-alone embellishments on fabrics, 

as well as non-continuous repeat patterns.

You can create lots of brushes like this from 

photos or scanned items. The brushes will stay 

in your Brushes Palette until you change your 

Brush Set, and then Photoshop will ask you if 

you would like to save the changes made to the 

current set. You can also create a completely 

new set with your own brushes, by deleting all 

the brushes in your current set and then creating 

new brushes. All you need to do then is to Save 

the brushes (click that little arrow in the top right 

of your Brushes Palette to get the option).

 

Seamless Pattern
Let’s move onto something a little trickier: a 

seamless brush; one that, when used, creates a 

continuous pattern. These can be anything from 

knitted fabrics to lace borders.

We start pretty much the same way as we 

did with the previous brush, by scanning or 

photographing a piece of fabric or clothing. Here 

we need to make absolutely sure the piece is 

laid out straight, and that we capture it dead-
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this case. To rectify that, we need to transform 

it a bit to get it straight. If we don’t do this, it will 

not align properly later. 

First, we may want to show the Grid, to get an 

idea of where the lines need to be (View > Show 

> Grid). We then select the canvas (Select > 

All), and then go to Edit > Transform > Skew. 

This will let us straighten the horizontals and 

on from above. No odd angles. Also, we need 

to make sure to capture enough of it, so the 

pattern can be “stitched” together without any all 

too obvious seams later.

I photographed a section of cotton lace border 

(Fig.08) that I’d like to use. As the border itself 

is white, I put it on a black piece of fabric (you 

could use anything, as long as it’s dark) to get 

the best contrast. We desaturate as before and 

then invert the colors (Fig.09). This is necessary 

this time round because we want the lace to 

be the brush, not the surroundings. Some 

adjustments in the Levels may be needed, as 

before, so work your magic!

The next important step is cropping the image. 

We need to make absolutely sure that we know 

where the pattern starts and ends, so that we 

can crop it right at that point. If it is a tiny repeat 

pattern, as in this case, we can choose a larger 

section to make it less obvious that it’s been 

stitched together later on when used. The more 

variation the better, as it makes it look much 

more believable (Fig.10).

When cropping, it may become more apparent 

that the pattern isn’t perfectly straight – like in 

verticals out, as well as squish them to make 

them line up better (Fig.11). Once we are done 

with this, we can crop the pattern (Fig.12).

We now proceed as before with making a new 

brush, and once we’ve done this we need to 

adjust it to indeed create a seamless pattern:

We open a new canvas and select the brush. 

We then open the Brush Presets palette 
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(Fig.13). Click on Brush Tip Shape at the top of the list on the left. You’ll 

see lots of options there, but the one we need to pay attention to is the 

Spacing (Fig.13a). Moving the slider to the right spaces the brush out 

more and more. Move it until you can see the segments touching each 

other, instead of overlapping one another. Try the brush on an empty 

canvas, as the preview isn‘t quite that accurate. If there’s a gap between 

the segments, or they still overlap, fine-tune the Spacing manually by 

increasing or decreasing the percentage. Once you‘re happy with it, create 

a new brush preset from the existing one so you don‘t have to do adjust it 

every time you want to use the brush (Fig.13b). 

This kind of brush is useful for large surface texture or embellishment, like 

lace and embroidery borders.

By the way, if you cannot tell if a brush is aligned right because your 

straight line drawing ability is a bit under the weather – like mine – just 

press and hold the Shift key on your keyboard while you draw the line – it 

will automatically be straight.

Hand Painted Patterns
Of course, we can also paint patterns by hand, or even make small 

brushes such as (dotted, dashed or solid) circles, swirls, zigzags, or 

whatever you can think of that will help with painting patterns by hand. I 

usually like to paint all my patterns, no matter what they are, and then use 

them as brushes, rather than photographing actual items. Painting and 

designing your own patterns really gives you endless freedom.

The method for creating a brush for these is the same as the two 

previously described, depending on whether you want a seamless pattern 

or a stand-alone/repeat one.

Using Fabric Brushes
Download the Free Brushes with this tutorial and we’ll have a look at how 

to best use the main brushes in the set. You will notice when you open it 

in Photoshop that I’ve already adjusted the settings of the brushes so they 

work as they should, but that shouldn’t stop you from playing around with 

them. 

The easiest ones to use are the Single Pattern brushes. I have not 

provided any settings for these, as they are usually stamped onto an 

image rather than used to paint. Here are two examples of brushes like 

that (Fig.14).

When using these kinds of brushes, always make sure you use them on 

a separate layer as they need to be adjusted. Why? Because they need 

to follow the flow and folds of the fabric they are on, and have to have the 

right perspective, too.

It’s quite simple, really, though you may need a little bit of practice with 

this:

Here is one of the patterns on fabric with folds (Fig.15). If we want the 

pattern to slightly wrap around something, like the side of a dress, we 

first need to adjust the perspective of it. To do this, we go into Edit > 

Transform > Perspective. We now push and pull at the corners and sides 

of the Transform tool until we get it roughly in the right position. If some 

of the pattern is going over the edges of the fabric, it shouldn’t be of any 

http://www.2dartistmag.com


Custom Brushes Fabrics & Lace

page 67www.2dartistmag.com Issue 045 September 2009

concern to us at the moment. Let’s continue with making the pattern fold. 

The fun starts here!

If you’re working on a small area in a rather big painting, you may want to 

select the area the pattern is in with the Marquee Tool. This will cut down 

the loading time of the tool (or Filter?) we’ll be using next: Liquify. You can 

find it under Filter > Liquify, and it‘s a small program all in itself (Fig.16).

To do what we are about to do, choose the Forward Warp Tool and adjust 

your Brush Size to what is appropriate for what you need. The brush 

should be slightly larger in diameter than what we are about to warp. Also 

make sure you have Show Backdrop ticked at the bottom, and Mode 

set to Behind, while Opacity should be something between 50 and 70. I 

personally also like to show the Mesh, as it gives me a better indication of 

what I am doing.

Now we gently start to push the pattern into the folds of the fabric, using 

short, one-way strokes, lifting the brush off after every stroke. Resize the 

brush as often as needed. For large or long areas, such as flower stems, 

we need to start at one end and slowly work our way to the other end with 

repeated brushstrokes. It is impossible here to make long strokes as it 

will only warp the part where you first set your brush down on the canvas 

(Fig.17).

The deeper the folds, the more we need to push the pattern into them, 

creating the illusion of it bending with the fabric. If folds overlap, it may 
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checkered square) – this will do what it says: 

locks all transparent pixels, leaving you to paint 

happily over everything else on the layer, which 

in this case is the pattern, until you are happy 

(Fig.19).

This is pretty much what you need to do every 

single time you use a complete fabric texture or 

just a pattern – no matter what it is. If it’s not a 

flat surface, it needs to go with the direction of 

the fabric. There is no way around that. At all!

All the textures and embellishments in the final 

image of this tutorial were applied with that 

same method.

be wise to first cut the pattern up and actually 

removing part of it (where the folds would hide 

the pattern) and then putting it back together 

before using the Liquify Filter.

Once we have our result (Fig.18), we may 

have to adjust it some more here and there, as 

sometimes it is hard to judge where the pattern 

is going while using the Liquify Filter. 

At this point, if parts of the texture or pattern go 

over the edges of whatever they are on, just 

erase those parts.

This still doesn’t look quite right because the 

pattern is one single block of color; it needs 

shadows and highlights according to the light 

source in the painting, and according to the folds 

of the fabric. To easily paint over the pattern we 

click on the little Lock Transparent Pixels icon 

at the top left of our Layer Palette (the small 

By the way, sometimes a brush like these looks 

even better if you apply the Median Filter or a 

slight Gaussian Blur, just to make especially 

photographed or scanned textures look more 

painted, and thus more part of the image.

So now that we have looked at one brush in 

action, what do some of the other brushes look 

like? I could just refer you to the final image, 

but figured it’d be nice to see them just by 

themselves for a clearer view (Fig.20 – 24).

Conclusion
Working with these kinds of brushes may take 

some getting used to, but the result is well worth 
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the time taken. I truly hope this little tutorial is of 

some help in getting you started with it all.

Detailing your paintings should be fun, and with 

these brushes it will hopefully be just that. And 

if you’re really into it, you may even find yourself 

keeping an eye open for new patterns all the 

time, be it when shopping, reading magazines 

or browsing online. Or, like me, you’ll start a 

whole folder on your computer of hand-painted 

patterns that you can adjust or modify as you 

please, when you please. The possibilities are 

truly endless…

Happy brushing!

Nykolai Aleksander
For more from this artist visit

http://www.admemento.com/ 

or contact

x@admemento.com
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“...thinking about the 
character and that 
what he/she does 

plays a great part in 
their appearance.”

This series of tutorials aims to show some of the methods and processes used to design and develop characters 

from initial thumbnail sketches through to a final concept. The series will be divided into five parts and will focus on 

the general design methods commonly used by character artists. It will begin with quick sketching techniques used to 

suggest ideas and develop a theme before moving onto creating variations once a subject is established. The third 

instalment will culminate in a finished concept design, after which we will move onto the importance of posing your 

character and the impact this has on their personality. The series will conclude with a chapter dedicated to choosing 

suitable eye levels and camera views to best convey an emotional state or emphasise a storyline.

Chapter 1 | Thumbs & Silhouettes

Chapter 2 | Visual Brainstorming – Variations on a Theme

Chapter 3 | Speed Painting & Concept Design 

The third instalment will assume that all of the key characteristics have been established 

and ready to be moulded into a final design sheet. Colour schemes along with detailing will 

be covered in this chapter which will result in a finished concept.

Chapter 4 | Dynamic & Exaggerated Poses 

Chapter 5 | Camera Placement, Framing, Fore-shortening & Distortion
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Part 3: Speed Painting & Concept Design
Software Used: Photoshop

Introduction
In this third part of the tutorial series we will take on board what we have 

learned in the previous chapters of this series, by Darren Yeow (Part 1) 

and Bruno Werneck (Part 2), and we will now create a model sheet based 

on our character design.

We will assume that the potential modeler for our character concept is 

an experienced one, is capable of working from a modeling sheet, and 

that he/she has a good understanding of form. And from this assumption, 

we will paint the character from an angle so that all shapes have better 

definition, and we therefore avoid the “stiffness” often inherent with a 

standard view representation.

Anatomy
I tend to incorporate the anatomy base early on into my design phase so 

that whilst I am sketching my way to the final design, I already have the 

anatomy of the character underneath. That way, each new part or design 

follows the same base so that there is no confusion or odd exaggerations 

in form.

With the anatomy base (Fig.01) ready to be painted upon, I start to 

lay down brushstroke after brushstroke onto a new layer, whilst not 

being too bothered by exact lines at this stage because I tend to 

mold and carve my forms as I go along. 

Front View
I try to keep the armor that I paint in line with the anatomy 

underneath so that I know it is functional, and that all parts are 

where they should be, to ease the future modeling and rigging 

work that our colleagues will do (Fig.02). 

I continue to define parts by laying down basic brushstrokes 

with a light source in mind to better define the form. It is 

important not to zoom in too much here as it is easy to get caught 

up in details at a stage when they don’t really matter. Try to keep 

yourself from doing so with the mantra, “It will all make sense in 

the end.” 

The skin and armor are too close to one another value 

wise, so I create a new layer on top using the Overlay layer 

blending mode. I paint with white over where I want the skin 

to be lighter. This helps the character to read better, and 

now the skin and metal stand apart (Fig.03).
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That layer blending mode has a tendency to 

change the hue of what is underneath it, so by 

creating a Hue/Saturation Adjustment Layer on 

top of your painting, which is set to Saturation: 

-100, it will help your values stay gray rather 

than becoming blue, for example (Fig.04).

I continue to add to the details and pieces 

of armor of the design, thinking about the 

character and that what he/

she does plays a great part in 

their appearance. Personally, I tend to create 

my characters by function rather than taking a 

more aesthetical approach. And in this case, 

I’m trying to visualize the armor on my body 

and how it would move if I were to be wearing it 

myself. Usually in this way I can figure out what 

works and what doesn’t (Fig.05). I still haven’t 

really gone into great detail of the line quality or 

shapes. This will be addressed at a later point; 

right now it’s all about getting the necessary 

information down – the spit and polish comes 

later. So let’s move onto our rear view, now.

Rear View
If you think of your character as a form, the 

front could easily also be the back (Fig.06). So 

I copy the character over to the right, and that 

will become our rear view. Due to the fact that 

the character has been painted at an angle 

makes this phase is a little bit trickier than if it 

were drawn in a standard view, but it’s not a big 

problem.
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Imagine a line going across the forms you have 

painted – the centerline – and this will help with 

your understanding of how to create the back 

view a lot easier (Fig.07). 

I usually create the centerline in my mind, but 

because this is a tutorial I will illustrate the 

thought process for you (Fig.08). By using the 

centerline while flipping anything in perspective, 

it shouldn’t be hard to paint as long, as the flip is 

a 180 degree rotation.

I have now reached the point of the back of the 

design where the armor is starting to become 

quite defined (Fig.09). I want to make sure it is 

interesting from all angles so I will start to paint 

the side view now.

Side View
I create a new layer at the top of the image and 

lay down some straight lines from the essential 

points, to use them as my “anchor points”. Areas 

that define a form should get a line. Taking the 

helmet as an example, there will be a line at the 

top of the helmet, and a line where it will end at 

the bottom (Fig.10).

You can move parts around now in order to 

make it look its best. At this stage I tend to 

do a lot of adjustments and alignments. If I’d 

previously spent a lot of time defining too many 

details I would have had to redo them now whilst 
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making these changes, which wouldn’t be a very 

efficient workflow (Fig.11).

Adding Definition 
I am now at a point where I am satisfied with 

the adjustments made, and so I will now start to 

define the shapes in order to make it as clear as 

I can for our modeler to follow (Fig.12).

By creating temporary selections and painting 

within them helps me to keep the edges as clear 

as possible, without having to go over them lots 

of times to make them all nice and crisp. If you 

look at Fig.13 I have painted a small example 

of the technique for you. Here I have a fuzzy 

line between two shapes that I want to make 

clearer. I make the selection and paint inside 

it. By inverting the selection back and forth I 
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can continue to detail and paint without being 

bothered about the edges and keeping them 

clean. This is just a quick example, but it should 

help illustrate the method for you to experiment 

with.

By applying the same technique, the details 

and edges become defined enough for the 

character design to be suitable to be modeled 

from (Fig.14).

Color
As a final touch, and to add some color to the 

design, I create a new layer on top of all layers 

which I set to the Color layer blending mode. I 

paint in blocks of color to separate the parts of 

the design even further, making it easier for our 

modeler to follow and translate into 3D (Fig.15).

And we’re done! 

Björn Hurri 
For more from this artist visit

http://www.bjornhurri.com/

or contact

bjornhurri@hotmail.com
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Chapter 1 – July
Introducing Photoshop’s Workspace, Graphics Tablets, Screen 

Calibration, Color Profiles and the Brush Tool

Chapter 2 – August 
Canvas Settings, Scanning Drawings, Swatches, Colour Pickers,  

Colour Theory, Layers and Custom Brushes!  
 

Chapter 3 – September
Composition Rules, Sketching and Perspective, Understanding 

Light and Blocking-In. In the third chapter we’ll be looking into 
the rules of composition, sketching and perspective, learning about 
determining and applying a light source in paintings, which brushes 
to use for blocking in a sketch, and also what tools can be used for 

drawing straight lines without much hassle
 

Chapter 4 – October
Colouring from Greyscale, Colours beyond Blocking-In, Blending  

Methods and Using Photos
 

Chapter 5 – November
Quick Masks, Using the Wand Tool, Liquify Filter uses, Layer  

Masks – and Painting!
 

Chapter 6 – December
The Final Part: Finishing Touches, Filters, the Unsharpen Mask  

and Saving your Work

This Workshop Series will look at, just as the title suggests, all the things that we need to know to get us started with 

Photoshop – mainly for painting, but also for other things such as matte painting and photo manipulation, which often 

use the same tools. We will be covering all the technical aspects of the programme, as well as some technical sides 

of painting that’ll help us starting to swing the virtual brush!

• Free Brushes
• Free Fibonacci Spiral (PSD)

http://www.2dartistmag.com/tutorial_resources/issue_045_sep_2009/tutorial04/tutorial04_sep09.zip
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Chapter 3 – Composition Rules, 
Sketching and Perspective, 
Understanding Light and 
Blocking-In

Software Used: Photoshop

Introduction
Sometimes it seems strange that so much 

technical knowledge is needed to even begin 

being creative in Photoshop. We’ve learned 

a lot in the last two workshops, and if you are 

still here now, reading this, then I can already 

tell you that you have the dedication it takes to 

make something truly great out of this!

As promised last month, we’ll be starting to paint 

this time. However, even this will require some 

background information that I find impossible to 

ignore. So let’s get on with it.

Of Fibonacci, Forms and 
Freedom 

Fibo-who? – Fibonacci, nickname of Leonardo 

Pisano, born around 1124 in Pisa, Italy, and the 

“greatest mathematician of the middle ages”. 

I’m pretty sure you have heard of the Fibonacci 

sequence – a sequence of numbers that he 

introduced to the Western World – which also 

featured in the film, “The Da Vinci Code”: 0-1-1-

2-3-5-8-13-21-34-55-86... 

You may wonder what this – or even 

mathematics – has to do with art? You’d be 

surprised. Here it goes:

The Fibonacci sequence – also coined the 

“God Number” – is present in many biological 

settings; this means flowers, trees, seedpods, 

arrangement of leaves on a stem, and even in 

the hierarchy of a honeybee colony. You may 

not be painting many bee colonies in your time 

as an artist, but when it comes to flowers 

and such things, it can be useful to know that 

flowers’ petals and seed arrangements (this 

is especially visible in sunflowers) adhere to 

the Fibonacci sequence. The only flowers you 

will find in nature have a petal arrangement of 

two adjacent numbers of the sequence, such 

as eight petals going in one direction, and 13 

in the other, beneath the first.

Now you may think that this is sort 

of useful to know, but kind of boring, 

as your audience will most probably 

not count every flower petal in your 

pictures. And you’d be right, to a point. 

But I had to start approaching this 

subject somewhere now, didn’t I?

This sequence is also known as the 

“Golden Sections” (Fig.01), which in turn can 

be translated into the Fibonacci spiral (Fig.01a), 

and can be found in nature as well (even though 

it‘s a less substantiated claim), like in the 

spiral of shells and the curve of waves. – It is 

perfection: mathematics revealing the beauty we 

see and create as artists.

If you are still not convinced that this has 

anything to do with painting, then think again. 

Why do we like something when we see 
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it? – Because it appeals to us. And I am not 

talking hot babes here, although they certainly 

have their merits as well. What I mean is the 

composition of a painting. How often have you 

looked at a painting and thought to yourself 

that you love how it all works together or that 

you simply love it, but don’t know why? This 

is most probably due to the fact that the 

painting adheres to the Golden Sections. 

Superimposing the Fibonacci spiral onto some 

of my paintings (so no copyrights are broken), 

you can see it works out, even with the ones 

that have the main subject in the centre 

(Fig.01b).

When you start sketching an idea, you 

don’t have to keep the spiral in mind. But 

when you feel something is off somehow, 

superimpose the spiral and you’ll 

most likely very quickly find out why. 

Funnily enough, most seasoned artists 

automatically stick to this recipe, without 

ever touching the Spiral. Convinced now? 

[Winks]

Sketching!
So, let’s look at sketching something then. 

There are several ways of going about doing 

that digitally, but if you’d rather do your 

sketches on paper, please feel free to do so. 

Some artists find it useful to begin an idea 

with a thumbnail sketch, which is a very small 

sized sketch simply showing the very basic 

composition and colors. Doing this on such a 

small scale saves time, and as you can see the 

entire canvas on your screen makes it easier 

for you to take in the whole composition and 

adjust things where necessary. For 

these kinds of sketches, all you need is 

a small canvas (something around 300 

pixels is a good size – I‘m just doing 

it larger for the purpose of this article) 

and a basic round hard-edged brush. 

Forget about details, just splash the paint 

on the canvas, and you may end up with 

something like what you can see here in 

Fig.02. 

So we have a landscape, looking pretty 

much like a desert, with some mountains 

and some kind of structure. Seems good 

enough to me, so let’s stick with this one, 

shall we?

If this is not your idea of sketching, and prefer 

line drawings before you even want to consider 

colors, that’s not a problem either. Here, too, 

you may want to start with a smaller canvas, 

although not quite as small as the one of the 

thumbnail sketch – 1000 pixels at either side 

should suffice – which can later be resized. 
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to Pen Pressure, so you may want to try this, 

too. Choose a dark color (black or dark brown, 

perhaps?) and you are ready to go. My result 

can be seen here in Fig.04. 

Not very neat, is it? – It doesn’t have to be. 

Let’s see about the composition now and apply 

the Fibonacci spiral – you can find it available 

for download at the end of this workshop as a 

conveniently layered PSD file; simply click on 

the Free Resources icon to download. Kind of 

works, right (Fig.04a)? 

You can of course open up a new canvas that 

straight away has the size you want to paint 

at, and simply have the canvas “Fit on Screen” 

(View > Fit On Screen) so you can see all of it. 

I personally dislike sketching on a white canvas, 

for two reasons: too bright, and also, I never 

start a painting on a white background, as white 

has the tendency to make your colors appear 

flatter and lighter than they actually are. The 

same goes for black, by the way. So for a line 

sketch, I like to use either a neutral color as 

the background – preferably one that I want to 

appear in the painting. You can either choose 

one before opening a new canvas, as discussed 

in the last chapter, or open a white canvas and 

then choose your color. You can apply it to the 

background by using the Paint Bucket Tool, 

which you find with the Gradient Tool in the 

tools palette (Fig.03). 

Once you’ve done this, add a new layer to the 

canvas and name it “Sketch”. This will now be 

the layer that we sketch on, and that, if you‘ve 

chosen to start on a small canvas, can later be 

dragged onto a bigger canvas and transformed 

for painting. 

Pick your Paintbrush, and a small round Brush 

Tip. I like setting my Size Jitter and Opacity 

If it isn’t totally spot on, don’t worry about it, 

but if it is totally off you may want to reconsider 

your composition and perhaps change a few 

things around. Totally central alignment of the 

elements in your painting only really works for 

certain styles of illustration, or more design-

oriented images.

By the way, if you have trouble with sketching 

things freehand, don’t hesitate to use references 

to look at – it really helps. There are several 

good websites out there that offer free stock 

images if you don’t have any photos that you 

have taken or can take yourself. Just please 

stay away from anything that is not labeled 

clearly as stock or royalty free; people can get 

mad when their pictures are used without their 

permission.

Now you may want to clean up the sketch a 

bit, especially if you’ve added an architectural 

structure, as I have in mine. Why? Because 

most architectural structures have straight 

lines, and adhere to perspective. Perspective 

is important even for landscapes, so you may 

want to consider doing what I am about to show 

you now. 
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Perspective
You will have seen perspective in action 

before, without even noticing it, because it’s 

always been there. When you were standing 

in a street, looking down it, or even up to 

the tops of the skyscrapers – the street, 

or skyscrapers, seem to get narrower the 

further away they get from where you are 

standing, and the lines of buildings seem to 

be at an angle, too. This is because they all 

run towards an invisible “vanishing point” at 

the horizon – or two, or three, or as many as 

you can think of. Let me give you a simple 

example of the famous cube.

In Fig.05 we have a square – a flat one – as if 

we are looking directly at it, perfectly centered. 

Let’s add some depth, and the square turns 

into a cube (Fig.05a). However, this one has 

no real perspective; there is no vanishing point 

(or maybe it’s just too far away for us to notice), 

it‘s just three-dimensional. Now, in Fig.05b, the 

very same cube is drawn with a vanishing point 

in mind. Instantly looks more realistic, right?

Eyeballing perspective works to a point, but is 

never quite accurate as our eyes love to play 

tricks on us. That’s where perspective grids 

come in very handy, as they show us every 

line, every angle we need to know 

about.

In newer Photoshop versions you have 

something called the Perspective Grid Tool, 

and I’ve heard it can be useful for some things, 

but not for everything. I don’t have this Tool in 

my Photoshop version, so unfortunately I cannot 

explain its proper use here. I am sure though, 

that if you Google this tool, you will find quite a 

few resources regarding its use.

In our case right now, however, let’s be old-

school and draw our own perspective grids. 

Besides, if you work on paper this is your only 

option anyway!

Before we start with this, I guess I’d better 

explain how to draw perfectly straight lines in 

Photoshop, as without them it’s pointless to 

draw a perspective grid. You have two options; 

both are time-efficient and easy to use. One 

of them will also be useful later on, when you 

actually paint, so please don’t dismiss this 

outright if you feel it takes a nanosecond longer 

to do that the first.

There is no need to add a new layer to the 

canvas for the first method, as new layers will 

automatically be created with it. Select a color 

that will stand out well from your sketch and 

background. Now select the Line Tool. You will 

find it under the Rectangle Tool (Fig.06), or, 

if you cannot be bothered to wait for the mini 

menu to pop up, just clock the Rectangle Tool 

and go to your Options Bar, where you can 

select the Line Tool (Fig.06a). The Line Tool 

does what it says: draws straight lines. You can 

change the line width and color in the Options 

Bar (Fig.06b), and depending on the size of 

your canvas, you may want to adjust this to 

something easily visible when your canvas is 

set to “Fit on Screen”. If you made the first line 

and cannot see it – if your canvas is zoomed out 

from its original size this happens a lot, because 

the stroke made is just too thin to be seen at 

that size – simply adjust your line width.

For the second method add a new layer to 

your canvas before you do anything else, and 

then choose the Paintbrush instead. Select 

the standard Hard Round Brush Tip for this, 

and make sure any kind of special settings are 

switched off, even the Size and Opacity Jitter. 

Make it small, as you don’t want big fat lines 

covering your canvas. 

To use the Paintbrush to make perfectly straight 

lines, you need to put your pen down on the 

canvas where you want the line to start, 

and then press and hold the Shift key on 

your keyboard while you draw the line. This 

works for horizontal or vertical lines. To 

draw straight diagonal lines, as you would 

need to for the grid, put the pen down on 

your starting point, and press and hold the 

Shift key while lifting the pen off the canvas 

and putting it back down where you want the 

line to end – the diagonal line will draw itself! 

For some fun, you can even continue to hold 

the Shift key and just dot your pen around on 

the canvas for lots of angled lines, or zigzag 

patterns – whatever takes your fancy! 

Note: What I have found is that it’s easier to 

draw freehand diagonals with the Line Tool, 

especially when you have to be precise, as 

you can see where the line will go before you 

commit it to the canvas. If you need precise 

vertical, horizontal, or 45-degree angled lines, 

simply press and hold your Shift key after you’ve 
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set your pen down on the canvas – the Line 

Tool will do the rest for you, depending on the 

direction you drag it into.

There are two types of perspective grids that 

come in useful for various things: the four-plane 

perspective, and the two- (or multiple) point 

perspective. These are probably not the official 

names for them, in which case I hope I will be 

forgiven, but this describes them pretty well 

anyway. In any case, I’ll show you both.

Two-Point Perspective
The two-point perspective is the easier one 

to draw, and also a very simple method of 

determining the perspective of architectural 

structures in a picture, so let’s start with that 

one.

First, draw a straight line where your horizon 

would be (just in case you don‘t know what that 

is, it‘s the imagined line where the sky touches 

the ground). That’s all – just draw that line. Now 

we have to determine where the vanishing point 

– or points – would be. The vanishing point 

is a point at the horizon that all lines run to. 

And it’s not always just one. In my example, 

there are two (Fig.07). 

To now draw a grid without any problems, 

all you have to do is put your pen down on 

the vanishing point and draw lines sticking 

out at various angles from this point, like 

sunrays, both above and below the horizon 

line (Fig.07a). They don’t all have to be at the 

same distance from each other – draw as many 

or as little as you like. 

If you now look at your Layers palette, you will 

see lots of new layers that are called “Shape”. 

Link all the Shape layers (but not with your 

Background layer!) and go to Merge Linked. 

You now have one layer with all your lines on it. 

Next up, go to Layer > Duplicate Layer and then 

check your Layers palette again: two layers with 

the same thing on them. Select one of these two 

layers – really doesn’t matter which one – and 

then select the Move Tool        , not just because 

you may need it in a minute but also because if 

you keep the Line Tool you will not be able to do 

what we are about to do: transform the layer. 

So, once you’ve got your Move Tool, go to Edit 

> Transform > Flip Horizontal, and your second 

layer will flip itself around. If it looks just right, 

leave it where it is. If it doesn’t, you can move it 

with the Move Tool to where you want it, making 

sure that the horizon line on both your grid 

layers line up (Fig.07b).

If you need to make one of the two layers longer 

to fit better on your picture, you can do this by 

going back into Edit, but instead of Transform 

you select Free Transform. Remember that 

only the active layer will be affected, so select 

the layer you want to transform first. In Free 

Transform, you get the same box around your 

layer as you got with the Crop Tool: you can 

rotate it by its corners, or stretch and squish 

it by its mid-line dots. For this one, I suggest 

you simply grab one of the mid-line dots on the 

side and pull on it (Fig.07c) until you reach the 

desired size. Apply the transformation by either 

hitting the tick mark icon in your Options Bar, 

by double-clicking your image, or by selecting a 

different tool. If you want, you can now merge 

the two grid layers. And there’s your finished 

perspective grid (Fig.07d). You could of course 

continue drawing lines all around the vanishing 

points if you need them. This one would be, as 

said, for a single structure.

Four-Plane Perspective
Now for the four-plane perspective. This one 

only uses one vanishing point (although two can 

be used as well, to make it really confusing). 

This is great for painting rooms within a building, 

or whole cityscapes, or even landscapes…

You can start out in two ways: either by 

determining the vanishing point (on an imagined 

horizon line), or by drawing a rectangle or 
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square (like the back wall of a room). When 

doing the latter you have more freedom 

regarding the grid we are about to draw 

(Fig.08).

The first option of placing a vanishing point 

anywhere on the canvas would continue with 

drawing a big X on the canvas, with the lines 

crossing through the vanishing point, and then 

adding the square or rectangle, with the corners 

touching the lines. This gives you a centered 

perspective and isn’t always that dynamic in 

terms of composition.

Anyway, let’s stick with the one I‘ve started here. 

We draw four lines, one through each corner 

of the rectangle, starting at the vanishing point 

(Fig.08a). Now keep drawing lines that radiate 

out from the vanishing point, one side at a time, 

until your canvas is full (Fig.08b). 

You can erase everything that is within the 

square, but don’t have to. I just find it easier, 

especially when drawing a room. Next up, draw 

the vertical and horizontal lines – in essence, 

bigger and bigger rectangles around your 

original one, with the corners always 

touching the same lines as the original 

rectangle (Fig.08c). I suggest drawing 

the complete rectangle before starting on 

the next one, as this keeps the corners matching 

up. The finished result should look like a “mesh 

room” (Fig.08d).

If you’ve worked on multiple layers for this, or 

layers were created, you may want to merge 

all the layers into one to reduce your file size, 

as well as make it easier to remove the grid 

later or to adjust its opacity – something that 

comes in useful when painting and sketching, 

as those lines can be distracting (for this, 

I suggest to Merge Visible, after making the 

Background layer and any other layers you 

do not want to merge with the grid invisible).

Note: Remember that all vertical lines remain 

vertical, no matter what your perspective is … 

unless you happen to be drawing the leaning 

tower of Pisa, that is.

Now try and apply a perspective grid to your 

sketch, according to what you‘ve drawn. In my 

case it’s a bit on the complicated side, as I need 

a mix of perspective grids for the landscape 

and the structure, with one of my vanishing 

points way off the canvas to the left. And yes, it 

confuses the heck even out of me! But it works 

(I think) (Fig.09).
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You can now refine your sketch according to the 

grid. I choose only to refine my structure, as the 

other stuff isn’t really bound to straight lines.

When it comes to architectural structures, it is 

vital to stick to the grid, as otherwise you might 

end up with something that even MC Escher 

would be jealous of: totally warped geometry. 

Think of a structure in 3D, rather than 2D, as 

demonstrated earlier with the cube. If you 

are good at working with 3D programs, by 

all means feel free to make a simple or even 

detailed model of whatever structure you want 

in your painting, and add it onto your canvas 

either as a reference “sketch“ or to paint over 

later. If you are really bad at drawing buildings, 

or even simple three-dimensional elements, 

try out Google SketchUp; it’s easy to use (it 

has a video walkthrough when you first start 

up the program), isn’t very big, and also free. 

If you use something like this just make sure 

to adjust the perspective of your painting to the 

perspective of your structure, or else you’ll end 

up with something truly wonky.

Blocking-In!
We are now ready to add the first layer 

of color. This stage is called “blocking 

in”, as all we’ll do is roughly lay the 

colors down on the canvas in blocks.

The best brushes to use for this are 

the Hard Round Paintbrush, an even-

edged textured brush, or a square 

brush (either smooth or textured) with 

the Size Jitter off, and Opacity Jitter on. You can 

find a few brushes like this for download at the 

end of this workshop – simply click on the Free 

Resources icon again to download them.

Note: Never (ever!) paint on your sketch 

layer! Rather paint beneath it, either on your 

Background layer or on a layer you add beneath 

the sketch layer. When working on the base 

of your painting, starting with a landscape or 

scene, there is no real need to add a new layer, 

but you may feel more comfortable with it so the 

choice is yours. I just urge you to not add a new 

layer for every single object in your painting, as 

this often ends up with a painting looking very 

“cut and paste”, because the different objects 

don’t really interact with each other.

If you did a thumbnail sketch, pick the colors 

from that with your Eyedropper Tool. If you 

didn’t, I suggest you compile a color scheme by 

picking colors and painting them on a separate 

canvas (Fig.10), or turning every color you 

choose into a new swatch (I prefer the first two 

methods, as I don’t work with the Swatches in 

my usual painting workflow). 

Consider your Light Sources
Something to consider when you start blocking 

in your painting is where the light would be 

coming from, and perhaps even whether 

there will there be a second or third light 

source in the picture, like candles, or a 

fire, or a lamp? You may have noticed that 

in my little thumbnail sketch I’ve already 

thought about it. But when just starting 

out, light and shadow can seem very 

daunting. So let’s look at it with a simple 

example.

Here’s a shape, a circle (Fig.11) – nice 

and flat. To turn this circle into a sphere, 

it needs light and shadow. Imagine this 

circle is sitting in the sun in a desert, at 

around mid-afternoon (Fig.11a); the 

light would touch it only on one side, 

casting the other into shadow 

and also making the new 

sphere cast a shadow on 

the ground (Fig.11b). 

But what if that one light source 

is a spotlight, like a desk lamp, 

and there is not much else in terms of 

ambient light? Things would change a bit 

then, as a spotlight is a directional light 

source casting a single beam (Fig.11c), 

and according to that the light area would 

look a bit different, as well as the shadows 

(Fig.11d).
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How about if that sphere sat outside 

somewhere at night, under a full moon, with 

a small fire going to keep it nice and cozy 

(Fig.11e)? Both the moon and the fire are light 

sources, but the fire is much closer than the 

moon is to the sphere, and so the fire becomes 

the primary light source casting some warm 

glowing light and more or less fuzzy shadows. 

The moon cannot possibly compete with this, 

but still has an influence on the sphere with a 

very light and ghostly hint of a glow, but not 

much in terms of shadows (Fig.11f). If the 

moon where the setting sun, the shadows 

from that light source would be much 

stronger – it is the sun after all – and 

overlapping with the ones from the fire. 

And if there are many different light 

sources casting an ambient light, there 

wouldn’t be much in terms of shadows, 

just hints here and there where the light 

doesn’t reach.

Taking all this into consideration, we 

determine our light source for the painting 

and start blocking in the colors. I want the 

sun to shine from somewhere on the right, 

near the horizon, and so cast my shadows 

accordingly. For the structure I add a new 

layer, because it will be easier later to work 

on it without disturbing the landscape (Fig.12). 

Instantly, we achieve depth, adding form to the 

shapes. 

We continue refining the scene, ignoring small 

details for now – you want to get the feel of 

the image right first before possibly wasting 

time on details that later may not work. Start 

using slightly smaller brushes, and maybe even 

change the Opacity and Flow manually in the 

Options Bar to layer our colors like washes, 

which will automatically make everything blend 

to a certain degree (Fig.12a).

By the way, if you make a mistake 

simply go into your History palette and 

either click on the Delete icon (the little 

trash can at the bottom), or click and drag 

the steps onto the icon. You can delete multiple 

steps at once by selecting any one step in the 

list, and then drag it and the ones below it into 

the bin – the ones below the selected step will 

follow automatically. Just make sure to never 

delete the very top step in your palette, as it will 

revert the image to its previously saved stage. If 

you decide that deleting the steps wasn’t a good 

decision after all, you can reverse it by going 

to Edit > Undo Delete States. This however 
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Set the Palette to Local (Perceptual), change 

the Colors to whatever number of colors you 

want. 256 will be the most you can get, and 

will obviously give you the broadest range of 

shades. So I’ll stick with that. In the drop-down 

menu of Forced, select None, and uncheck 

Transparency. Then set your Dither to None, too 

(Fig.13b). Hit OK.

Now, go back into Image > Mode, and select 

Color Table – another box will pop up showing 

you your Swatches (Fig.13c). Save them. Now 

you can Load the new set from your Swatches 

palette menu (click on the small arrows in the 

top right corner to see the menu), and away you 

go!

Conclusion
With this I shall leave you until next chapter, 

hoping that at least a little bit of what 

we’ve learned this time has stuck. It was 

quite a lot to digest, but you can always 

go back and check it up again.

Next time we will be looking at coloring a 

monochrome painting or sketch, adding to 

and changing things in a painting, applying 

different blending methods, as well as using 

photos – either directly or as brushes in our 

work. And this is where the freedom of digital 

painting will truly start …

Nykolai Aleksander
For more from this artist visit

http://www.admemento.com/

or contact

x@admemento.com

will only work if you haven’t done anything new 

to your picture yet. The moment you make 

just a single new brushstroke, the chance 

of recovering the deleted steps is gone … 

Forever. Really!

Note: If you feel fine about using colors 

straight away, I’d suggest not adding a layer 

to your canvas but to just fill it with a color 

that would be a good base for the painting, 

and then take it from there with broad, rough 

brushstrokes that you will then refine over the 

course of the painting. Use the same brushes 

for this as suggested for blocking in a line 

sketch.

Stepping back in time…
And last but oh so definitely not least, I need 

to seriously backtrack all the way to the first 

chapter of this series for a second, before 

brining this installment to a close, and rectify 

something that was brought to my attention 

by the lovely Lica Rodriguez on deviantART 

(http://jlr-lica.deviantart.com), who was kind 

enough to point this out to me: Turning colors in 

images (like photos) into Swatches is possible in 

Photoshop CS, and this is how you do it:

Open an image/photo – I‘m using a picture 

I took here in South Africa as an example 

because the color range is rather nice (Fig.13). 

Go to Image > Mode > Indexed Color. A pop-up 

box will come up (Fig.13a) that gives us a 

few options. The default settings won’t 

do, so here we go to change that: 
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impressing us once more with his character concept, 

“Hovercraft Parrot”, we welcome David back to issue 45 

to talk us through the creation process of this intriguing 

design. Based on a great back story, find out how David 

breathes life into his designs through his skilful brushwork 

and his ability to meld the rough with the smooth!

“The design is somewhat 
abstract because with the 
method I used kept changing 
the shapes until I found 
something interesting – this 
made the work more fun 
and the results became more 
of a surprise to me.”
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organisms. The design is somewhat abstract 

because with the method I used kept changing 

the shapes until I found something interesting 

– this made the work more fun and the results 

became more of a surprise to me.

Brushes
These are the brushes I used to create 

Hovercraft Parrot (Fig.00). I like to use several 

brushes in order to get more texture and detail 

variation without actually using any textures.

Concept
I started by drawing a quick concept, focusing 

on the top part of the character first and 

foremost (Fig.01). Here I was working quite 

simply with general shapes that I liked, but they 

did of course change throughout the process, as 

you’ll see. 

At this point, I’m using brushes 3 and 4 from the 

before-mentioned brushes (see Fig.00).

Lighting, Color & Detail
Still using brushes 3 and 4, the next stage was 

all about lighting and color, although nothing 

was yet definitive at this part of the process 

(Fig.02). I like to improvise whilst I create 

a character and so avoid making any final 

decisions so early on.

 

I started trying some ideas out at the bottom 

part of the character here (Fig.03) – I didn’t think 

the legs were working as a humanoid type. Still 

adding lighting and some detail, and still using 

brushes 3 and 4 (Fig.00) – not thinking about 

the background, but knowing that it was going 

to be dark or cloudy to compliment the character 

design and the concept.

Making Of ‘Hovercraft 
Parrot’
Software Used: Photoshop

About Hovercraft Parrot
This is a character design which is in fact more 

the design of a vehicle to be used for personal 

transport, or racing. It has to be like a hovercraft 

because the surface of the planet is very rough 

covered by small, crystal, organic plants. These 

tiny plants emit an electrical power and have 

small magnetic shields; they are connected to 

one another and they give energy to the planet 

and its inhabitants. The armor – the vehicle – 

absorbs the energy simply by gliding over these 

energizing plants.

Most of the planet’s surface is covered by these 

plants, as well as bushes and very small, dark 

rocks. The blue electrical plants are the ones 

that connect together – if there is too much 

energy they will blow away, eroding the terrain, 

but in doing so they create a surge of energy 

through which more of these new plants will 

come to life to take their place.

The planet doesn’t have any sun or water; it 

is simply driven by the energy of the electrical 

“I like to improvise whilst I 
create a character”
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Refining the design further still (still brushes 3 

and 4), I made a clear decision about the bottom 

part of the character at this stage; it was here 

that I knew I wanted it to be hovercraft looking 

(Fig.04).

I then changed some elements on the armor 

and the engine, trying to make it look more 

mechanical (again, using brushes 3 and 4) 

(Fig.05).

Another clear idea for the design I came up 

with was to give him wings to glide – some kind 

of flaps which, as well as being purposeful to 

help him in flight, are also built like armor for 

protection (Fig.06). I’m still using brushes 3 and 

4!

To finish up the character before moving onto 

the character, I changed some proportions 

and made some final design changes. I also 

added some light effects to the flying engine – I 

think they look clearer in their function like this 

(Fig.07). I was still using brushes 3 and 4 here – 

we’re about to see how the other brushes were 

used, though!

The Background
For the background design, I separated the 

figure onto a different layer to be able to paint 

behind it. I had more or less a clear of how the 
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colors and lighting were going to be similar to 

the colors I used during the character design. 

You can see that I started to apply some shapes 

and color down, using brushes 3 and 4, and also 

introducing brushes 1 and 5 (see Fig.00) to the 

mix, too (Fig.08). 

Using brushes 7 and 8 (see Fig.00) I continued 

to add the small yellow plants, whilst brush 9 

was helpful to apply some brightness and make 

the areas around the plants shine, indicating 

their ability to emit light and electricity (Fig.09).

Close-Ups
Here is a close-up of the background finished 

(Fig.10). At this point I’d used all of the brushes 

shown in Fig.00. Keeping the desaturated tones 

I added some yellow-brown hints to give it a 

mossy look, and I made it clearer that the plants 

were connected by adding some small sparks 

between them.

Finally, here is a close-up detail of the character; 

even for the final detailing I was using brushes 

3 and 4 (Fig.11-12). I kept some areas more 

detailed and left others loose, adding color and 

shapes to give detail without explaining the 

shapes too much, keeping life in the brushwork 

and the design.

The final composition can be seen in Fig.13. 

Thanks for reading!

David Munoz Velazquez
For more from this artist visit

http://www.munozvelazquez.com/

or contact

munozvelazquez@gmail.com

“Keeping the desaturated 
tones I added some yellow-

brown hints”
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